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About This Guide 
Purpose of this Guide 

This user guide is designed to provide user-friendly, detailed instructions for performing all tasks associated 
with using the Abacus Data Scheduler. This document attempts to communicate a certain level of detailed 
understanding about Abacus Data Scheduler and its system functions to the user. The document lists all 
activities and narrates the entire process logic that will be built into the application. 

 

Who should read this Guide 

This guide is intended for users of the Abacus Data Scheduler product. This document helps the users to 
integrate Abacus with third-party applications. The document also provides step-by-step procedures to 
retrieve data from the third-party applications to the Abacus database. 

 

How this Guide is organized  

This guide is divided into the following chapters: 

Chapter 1 – Getting Started explains the overview of Abacus Data Scheduler, Starting Abacus Data 
Scheduler, and the User Interface. 

Chapter 2 – Data Import Jobs explains how to create a new data import job from file and database, Run 
the data import job, and view and purge log options. 

Chapter 3 – Account Center Jobs explains the overview of Account center jobs, how to populate fields to 
account console, how to retrieve log files from account the controller, and read account center log files. 

Chapter 4 – ReproDesk Jobs explains the overview of ReproDesk jobs, Abacus – ReproDesk integration, 
creating ReproDesk import jobs, and run import jobs. 

Chapter 5 – KIP Jobs explains the overview of KIP jobs, how to populate fields to KIP Request application, 
how to transfer settings to KIP controller, and read KIP log files. 

Chapter 6 – MetaPrint Jobs explains the overview of MetaPrint jobs, MetaPrint – Abacus Data Scheduler 
direct integration, Server integration and Client integration, integrating MetaPrint log files with Abacus Data 
Scheduler, Create and Run MetaPrint jobs. 

Chapter 7 – Abacus Audit Jobs explains the overview of Abacus audit jobs, how to create and execute 
Abacus audit jobs. 
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Chapter 8 – Data Export Jobs explains the overview of Data export jobs, how to create and execute data 
export jobs. 

Chapter 9 – IPlot Jobs explains the overview of IPlot jobs, how to create and execute the IPlot jobs. 

Chapter 10 – Fiery Jobs explains the overview of Fiery jobs, how to create and execute the Fiery jobs. 

Chapter 11 – Central Server explains the overview, creation and execution of Import Data and Data Sync 
jobs. 

Chapter 12 – Active Directory Jobs explains the overview, how to create and execute the  Active 
Directory jobs. 

Chapter 13 – HP DesignJet Jobs explains the overview, how to create and execute the HP DesignJet 
jobs. 

Chapter 14 – XeroxJBA Jobs explains the overview, how to create and execute the XeroxJBA jobs. 

Chapter 15 – LaserTrack Jobs explains the overview, how to create and execute the LaserTrack jobs. 

Chapter 16 – Konica Jobs explains the overview, how to create and execute the Konica jobs. 

Chapter 17 – Cisco Call Manager Jobs explains the overview, how to create and execute the Cisco Call 
Manager jobs. 

 

 

Typographical Conventions 

Before you start, it is important to understand the typographical conventions used in this guide. 

This Represents 

Bold Menu, any option on the menu, radio button, check box, 
command button or a link. 

 
A note, providing additional information about a certain topic. 

 
An important message not to be ignored. 
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How to Get in Touch 

The following section provides information on how to obtain support for documentation and software. 

 
Documentation Support 

For any questions, comments or suggestions on the documentation, contact us by email at 
abacussupport@mirrorplus.com  

Technical Support 

If you have any problems, questions or suggestions regarding this software, email us at 
abacussupport@mirrorplus.com.  While contacting technical support, please have the following information 
ready: 

1. Abacus version 

2. The operating system 

3. A description of the steps leading to the problem 

4. The exact message that appeared when the problem occurred, or any other message that 
appeared on your screen 
 

For additional information:  

Please contact: MirrorPlus Technologies Inc via email, and / or phone: 

Email: abacussupport@mirrorplus.com 

Phone: 1-877 TRY ARC1 (Option 2 for Abacus Support) 

www.mirrorplus.com 

mailto:abacussupport@mirrorplus.com�
mailto:abacussupport@mirrorplus.com�
mailto:abacussupport@mirrorplus.com�
http://www.mirrorplus.com/�
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Chapter 1 
Getting Started - Abacus Data Scheduler  
In this chapter, you will learn about: 

5. Overview of Abacus Print Cost Recovery System 

6. Starting Abacus Data Scheduler 

7. Understanding the Abacus Data Scheduler Interface 
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Overview of Abacus Print Cost Recovery System 
Abacus Print Cost Recovery System is a software solution to track and bill all the print activities for a 
company.  

Using the Abacus Print Cost Recovery System, all the printing activities are tracked and billed on a project 
to project basis. This ensures that printing costs associated to an individual project are properly assigned. 
This information is required to bill the clients for reimbursable expenses incurred while printing. It also helps 
to manage the overhead costs associated with printing activities, which may not be reimbursable. 

The Abacus Print Cost Recovery System is composed of several modules, which have been installed on 
your network. Each time you perform an activity (print, scan, copy or fax) on your network, the Abacus 
Tracking Server will intercept the activity request, and trigger a billing pop-up for you to fill information 
regarding the project, the print media, and the purpose of the activity. 

Once the information is entered, the data will be added to the Abacus database. This information is 
accessed to prepare reports on your printing activity. 

Several applications are involved in this process. These applications have been pre-configured in your 
system by the reprographics provider. The applications include: 

8. The Abacus Database 

9. The Abacus Server 

10. The Abacus Tracking 

11. The Abacus Manager 

12. The Abacus Data Scheduler 

13. The Abacus Billing Pop-up 

The Abacus Data Scheduler is a component, which runs on the server and allows creating, modifying, 
and scheduling the data import jobs, Repro Desk jobs, KIP log files jobs, Oce Account center jobs, etc. The 
Abacus Data Scheduler runs all the jobs scheduled at regular intervals based on the job schedule. To run 
the scheduled job, Abacus Schedule service should be running at all times. 

Starting Abacus Data Scheduler 
The Abacus Data Scheduler is generally installed on a single workstation within your office network. This 
workstation should be the one, which is normally available to the Abacus Administrator. To launch the 
application, follow the given steps: 

To start Abacus Data Scheduler: 
1. Click the Start button  point to Abacus  point to DataScheduler folder  click 

AbacusDataScheduler application. The Scheduler options window appears. 
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Figure 1: Scheduler options window 

2. Select either of the options: the Use Abacus Scheduler Service option or the Use 
Windows Task Scheduler. By default, the Abacus Data Scheduler runs on the internal 
scheduler service. To run on windows scheduler service, click Use Windows Task 
Scheduler option. 

3. Enter valid windows User ID and Password in the respective text fields.  

4. Click Save to save your credentials for future use. The Abacus Data Scheduler main screen 
appears after this. 
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Figure 2: Abacus Data Scheduler main screen 

Abacus Data Scheduler User Interface 
To navigate successfully in Abacus Data Scheduler, a proper understanding of the interface is essential. 
The following section illustrates the various parts of the Abacus Data Scheduler interface and its uses. 
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Figure 3: Abacus Data Scheduler user interface 

The Job List is on the left-hand side of the main screen. It contains a tree structure of various jobs that 
could be performed using Abacus Data Scheduler. The jobs include: 

1. Data import jobs 

2. Account center jobs 

3. Reprodesk jobs 

4. KIP jobs 

5. Metaprint jobs 

6. Data sync jobs 

7. Abacus audit jobs 

8. Data export jobs 

9. IPlot Jobs 

10. Fiery Jobs 

11. Import Data Jobs through Central Server 

12. Synchronizing Data through the Central Server 

Job Details window 

Job List 

Toolbar 

Menu 
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13. Active Directory Jobs 

14. HP Design Jet Jobs 

15. Xerox JBA Jobs 

16. Laser Track Jobs 

17. Konica Jobs 

18. Cisco Call Manager Jobs 

Whenever you create a new job, the job list is updated with the new job. A “+” sign beside a job means that 
there are new jobs created. Click the “+” sign to expand the tree structure and view the job names. When 
you select a job from the job list, the toolbar options are enabled. In the following screenshot, a project 
name Test is selected under the Data Import Jobs and the toolbar options are highlighted. Refer to the 
screen shot below. 

 
Figure 4: Job List 

 

The Job Details Window on the right-hand side of the main screen displays the job information. Whenever 
you click on a job name in the job list window, the details of that particular job are displayed in the Job 
Details Window. This gives you the job information, mapped fields,  and scheduled information, last time 
the job was executed, status of job execution, and remarks. 
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Figure 5: Job details window 

The Toolbar displays tools like New, Edit, Run, and Delete.  

• New is used to create a new job.  

• Edit is used to modify a job. 

• Run is used to execute a job.  

• Delete is used to delete a job. 

 
Figure 6: The Abacus Data Scheduler toolbar 

The Menu displays the menu items like File, View, and Help. 

Advanced Menu Options 

In the job list, right-click a job name to provide you with the advanced menu options.  
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Figure 7: Advanced menu options 

The advanced menu options allow you to modify the selected job, modify the selected job schedule, and 
delete or run the selected job. 

Scheduler Options 
Abacus Data Scheduler is designed to run on two different modes: 

• Abacus internal scheduler service  

• Windows task scheduler service 

 You can also change the scheduler options based on your requirements. 

To change the scheduler options: 
1. On the Options menu, click Scheduler. The Scheduler options window appears. 
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Figure 8: Scheduler options window 

2. By default, the Abacus Data Scheduler runs on the internal scheduler service. To run on 
windows scheduler service, click Use Windows Task Scheduler option. 

3. Enter valid windows User ID and Password in the respective text fields.  

4. Click Save to save your credentials for future use. 
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Chapter 2 
Data Import Jobs 
In this chapter, you will learn about: 

• Creating a New Data Import Job 

• Run a Data Import Job 
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Creating a New Data Import Job 
This option allows you to create a job to import data into the Abacus database from other databases and 
files.  This is usually performed by users with administrator rights. The data that you can import are: 
projects, activity, clients, users, media, phases for projects, and so on.   

Creating a new data import job from a file 

You can import data into the Abacus database from the excel files.  

To create a new data import job from a file: 
1. On the job list, select Data Import Jobs. 

2. To create a new data import job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar. 

Or 

 On the File menu, click New Job.  

The Enter Data Import Job Details window appears. 
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Figure 9: Enter Data Import Job Details window 

3. Enter the Job details. 

a) Enter the job name in the Job Name text box. 

b) Select the data to be imported from the Import Data drop-down list. 

c) Select the Import Source as File from the Import Source drop-down list. 

4. Click Next to continue. The Config File Source window appears. 
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Figure 10: Config file source window 

5. Select the DataSource to configure an import job. 

a) Select an appropriate file type from which the data is to be imported. The available option 
in the Type drop-down list are: log, csv, txt or Excel file formats. 

b) Click   (buddy button) and select the file residing path. 

c) Select an appropriate Delimiter used to separate the values. The available options are 
Custom Delimited, TABDelimited, and CSVDelimited. The most common delimiters are 
colon, tab, and comma. 
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d) Select an appropriate option whether the input file has column header or not. 

6. Click Next to continue. The Preview Import Data window appears. 

 
Figure 11: Preview Import Data window 

7. Select an appropriate Import Options. 

 Allow Duplicates option allows duplicate copies to be imported. 

 Update Existing option modifies the existing files. 

 Sync Data option synchronizes all the files. 

8. Click Next to continue. The Field Mappings window appears. 
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Figure 12: Field Mappings window 

9. In the Field Mappings window, the source fields are mapped to the corresponding 
destination fields. You can also review and change the mapping if required. Column and 
Row filters can be set here depending on the conditions of import. Follow the given 
procedure: 
 
Select the Source Fields and then click corresponding Column Filter to apply filter. The 
Apply Filter window appears. 
In this example, the above screenshot shows filter condition to be applied for the source 
field – Column: 3. 
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Figure 13:  Apply Filter window 

10. Select an Operator from the drop-down list. The available options are:  =/in, between, 
!=, StartsWith, EndsWith, Contains, <, and >.  
 

 “=/in” is used for specifying “if the value is equal to or in” 

 “between” is used for specifying “if the value is between 2 values say, 1-100” 

 “!=” is used for specifying “if the value is not equal to” 

 “StartsWith” is used for specifying “if the value starts with” 

 “EndsWith” is used for specifying “if the value ends with” 

 “Contains” is used for specifying “if the value contains” 

 “<” is used for specifying “if the value is lesser than” 

 “>” is used for specifying “if the value is greater than” 

11. Enter the values for the selected operator and click Add.  

12. Select appropriate actions.  
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 Click Do not Import Column data option to ignore the column values and use a 
selected default value.   

Or, 

 Click Do not Import Row option to ignore the whole row.  
In the above example, if the column: 3 value is equal to inactive, then do not 
import the entire row. 

13. Click Apply. The filter conditions are applied in the Field Mappings window. 

 
Figure 14: Column filters 

14. Click Configure Row Filters to apply the row filters. The Row Filters window appears. 
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Figure 15: Row Filters window 

15. Select the appropriate filters. 

16. Click Close. In the above example, if the source column: 3 value is equal to inactive, then 
set the project status value as inactive. The Field Mappings window appears with the 
applied row filter details. 
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Figure 16: Row filters 

17. Click Next to continue. You may encounter with warning messages. However, it is not 
mandatory to apply filter conditions for all the columns. 
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Figure 17: Data Import warning 

18. Click Yes to continue. The Schedule Job window appears. 
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Figure 18: Schedule Import Job window 

19. The Schedule job window allows running the activity automatically at specified intervals. 
If you choose not to schedule a job, you can manually execute the job using Run Job 
option. 

 Select the Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Time Interval to Schedule area becomes disabled. 

 Or, 

 Clear the Do not schedule this job check box to schedule the job. Note that the 
Time Interval to Schedule area is now enabled. 

20. You may choose to schedule a job at regular intervals or on daily basis or weekly basis 
or monthly basis as per requirement. 

 Select At Regular Interval check box. Specify the hours, minutes, and seconds 
at which the job is automatically executed. For example, every 4 hours, 5 
minutes, and 5 seconds. 

 Or, 
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 Select Daily at check box.  Specify the time at which the job is automatically 
executed. For example, daily at 2:34:15 PM.  

 Or, 

 Select Weekly at check box. Click a day and time at which the job is 
automatically executed. For example, every Monday at 5:00:00 PM.  

 Or, 

 Select Monthly at check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

21. Click Next to continue. The Finish Import Job window appears. 

 
Figure 19: Finish Job window 
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22. Review the import job details and click Finish.  
 

Click Back to go back to the previous screen anytime.  

 
The new job is added in the job list under Data Import Jobs.  

Creating a new data import job from a database 

You can import data into the Abacus database from third-party databases. Abacus Data Scheduler 
supports importing projects from the following databases: 

• MS SQL Server 

• MS Access 

• Oracle 

• Deltek Advantage 

• Semaphore 

• Deltek Vision Projects 

You can import data such as activities, clients, users, media, page sizes, phases for projects from: 

• MS SQL Server 

• MS Access 

• Oracle 

To create a new data import job from a database: 
1. On the job list, click Data Import Jobs. 

2. To create a new job: 

 Right-click the Data Import Jobs and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or 

 On the File menu, click New Job.  
The Enter Data Import Job Details window appears. 
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Figure 20: Enter Data Import Job Details window 

3. Enter the required fields and click Next. The Configure 3rd Party Source Database 
window appears. 
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Figure 21: Configure 3rd Party Source Database window 

4. Select the database type to be imported from the Import Database Type drop-down list. 
In the above example, the database type is MS Access. 

5. You can either enter the database connection information or use DSN. 

a) If you opt to enter the database connection information: 

b) Enter the name of the server where database is installed or click  (buddy button) to 
select the path of the server. 

c) Enter the Database name in the Database text box. 



 
 

Abacus Data Scheduler 
         33 of 245 
 

d) Enter the valid UserID and Password to connect to the database. 

e) If you opt to use Database Source Name:  

 Select the Use DSN check box in the DSN / File section. 

Once you select Use DSN check box, Database connection info  section is disabled. 

 Click   (buddy button) to select a DSN / File name.   

   The ODBC Data Sources window appears. 

 
Figure 22: ODBC Data Sources window 

6. Click the appropriate option. The options are: System DSN, User DSN, or File DSN and 
select the required DSN Name from the list. Then click OK.  

7. Enter the SQL Query in the SQL Query text area in the Configure 3rd Party Source 
Database window. 
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Figure 23: SQL Query section 

8. Click Next. The Preview Import Job window appears. 

 
Figure 24: Preview Import Data window 
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9. Click here to follow the remaining procedures. 

Run Data Import Job 
Run Job is used to manually execute or perform a data import job.  

To run data import job: 
1. Right-click the job name from the Job list and click Run Job. 

                   Or, 

                    Select the job name. On the File menu, click Run Job. 

2. Wait till the data is imported. The job status and remarks are displayed in the job details 
window. 

 
Figure 25: Job details window - Run job status and remarks  
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View and Purge Log 

View log option gives you a run-down of all the jobs that were executed, date and time of job execution, and 
the status of the jobs.  

Purge log clears the screen by deleting all the log details of the jobs that were executed.  

To view and purge log: 
1. In the job list, execute a job by Run Job command. The job information is displayed in 

the job details window. 

2. Click View Log corresponding to the Last Execution section.  

 
Figure 26: Import job log details screen 

3. Click PurgeLog to delete all the log details, a message box appears click OK.  

 
Figure 27: Purge log – message 

4. Click Go Back to return back to the previous screen. 
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Chapter 3 
Account Center Jobs 
In this chapter, you will learn about: 

• Overview 

• Populating Fields to Account Console 

• Reading Log Files 
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Overview 
This section describes the integration of Oce Account Center with Abacus Data Scheduler. Current version 
of Abacus supports only integration with Oce Account Console. 

To integrate with Abacus you must have Oce Account Console. This could be installed on any machine. 
Here we assume that you have already installed Oce Account Console on your system. 

How the system works 

Abacus Data Scheduler pushes / populates the data to the Oce Account Center. The Oce Account Console 
is used to preview and publish this data on to the Controller. Whenever a user performs a scan job on the 
printer/Controller, a billing pop-up is displayed. The user fills the required information on the billing pop-up. 
This information is stored in log files that are generated by Account Logic. The log files are imported by the 
Oce Account Console. You can schedule an import job in Abacus Data Scheduler to retrieve the log files 
from the Oce Account Center. This retrieved data is manipulated by the Abacus system for generating 
reports and billing.  

Following is a pictorial representation of how the system works. 

 

 

 

 

 

 

 

Figure 28: How Abacus system works with account center 

Abacus Data Scheduler supports two types of jobs: 

• Populate Fields: Job that defines the Account Center dialog and pushes the Abacus data to 
the Account Center.  

• Read Log Files: Job to read the Account Center log files and import activities to the Abacus 
database. 
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Populating Fields to Account Console 
This option allows defining the billing dialog for Account Center and populating Abacus data such as 
projects, phases, billing codes, and notes to Account Console. 

To populate fields to account console: 
1. On the job list, click Account Center Jobs.  

2. To create a new job: 

 Right-click and select Create New Job.  

 Or,  

 Click New on the toolbar.  

 Or, 

  On the File menu, click New Job. 

The Create Account Center Job window appears. 
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Figure 29: Create Account Center Job window 

3. Enter a Job Name in the Job Name text box. 

4. Select Job Type as Populate Fields from the given drop-down list. 

5. Select Server Type as Account Console from the given drop-down list. 

6. Enter the server address in the Server Address text box. This is the name or IP address 
of the machine where the Oce Account Console is installed. 
Enter the Port as 8001. By default account console uses port 8001. If port is changed 
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during the installation, then enter the port number on which the Account console is 
configured. 

7. Click Next to continue. The Choose Field Options window appears. 

 
Figure 30: Choose Field Options window 

This window is used to choose the fields that appear on the billing dialog for Oce Account Center. 

Each field has the following options: 
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Check box – You can enable the field by selecting the check box adjacent to the field.  

Validation – This field indicates how the billing dialog validates a field. The following are the validation 
options: 

• Always – Selecting this indicates validation is mandatory for all activities (all print / copy / fax 
/ scan jobs) 

• OnDevice – Selecting this indicates validation is required for all activities performed at the 
Controller (This includes scan and copy jobs) 

• No – Selecting this indicates validation is not required. This implies that validation is optional 
and not mandatory. 

Sort Option – This field indicates how you want to arrange the data. 

• ASC – Selecting this indicates the data is arranged in ascending order. 

• DSC – Selecting this indicates the data is arranged in descending order. 

Display Option – This field indicates how the data is displayed. 

• All – Selecting this indicates the data is displayed to all the users in the Abacus database. 

• Valid Password / Pin – Selecting this indicates the data is displayed only to the users with 
valid password / PIN. Oce Account Center accepts only users with valid and unique 
password or PIN. 

• All-Abacus Users – Selecting this indicates the data is displayed to all the users except 
default Abacus users such as Admin, Master Admin users. 

• Valid Password / Pin – Abacus Users – Selecting this indicates the data is displayed only 
to the users with valid password / PIN except default Abacus users. 

8. Select one of the modes. You can either select User Mode or PIN Mode. 

 In the User Mode, the user is validated based on user name and password. The 
user’s names will be displayed in a drop-down list and password entered by user 
will be validated against the user name. 

 In the PIN Mode, the user is validated based on the PIN numbers that they enter. 

9. The optional fields include, configuring projects, media, phase, billing code, and notes. 
You can select as many fields as you require. 

10. For configuring project, select the Project check box.  

a) Select the Validation option. 

b)  Select the Sort Option. 

c) Select the Display Option. This indicates how you want to display the project Name or 
Number or Name (Number) or Number (Name). 
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11. For configuring media, select the Media check box. 

a) Select the Validation option from the given drop-down list. 

b) Select the Sort Option from the given drop-down list. 

• For configuring project phase, select the Phase check box. 

c) Select the Validation option from the given drop-down list. 

d) Select the Sort Option from the given drop-down list.  

e) Select the Display Option from the given drop-down list. This indicates how you want to 
display the phase Name or Description or Name (Description) or Description (Name). 

12. For configuring billing codes, select the Billing Code check box. 

a) Select the Validation option from the given drop-down list. 

b) Select the Sort Option from the given drop-down list. 

13. For configuring notes, select the Notes check box. 

a) Select the Validation option from the given drop-down list. 

b) Select the Sort Option from the given drop-down list.  

c) Select the Display Option. This indicates how you want to display the comments 
section. If you select Global Notes List, notes field is displayed as a drop-down list. 
Users can only select notes from the list. If you select Text Field, notes field is displayed 
as a text box. Users can enter their comments in the text box. 

14. Select the Device Information from the given drop-down list. This indicates the printer 
name. Select an appropriate printer from which the activities are to be tracked.  
 
Click Create New Device, to add a new device. The Create New Device dialog box 
appears. Enter the Device Name, Friendly Name in the respective text boxes and select 
the media. Click Create.  
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Figure 31: Create New Device dialog box 

15. Click Next to continue. The Schedule Job window appears. 
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Figure 32: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

16. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that when Don’t schedule this job check box is selected, the Run 
Job section becomes inactive. 

                    Or, 
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Clear the check box to schedule the job. Note that the Run Job section becomes active 
now. You may choose to schedule a job at regular intervals or daily or weekly as per 
needs. 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 2 hours, 52 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 9:45:28 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 6:15:00 PM. 

17. Click Next to continue. The Preview Summary window appears. 

 
Figure 33: Preview Summary window 
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18. Review the account center job details and click Finish. 

19. The new job is added in the job list under Account Center Jobs. 

 

Run Job 

The next step is to run the “populate / push” job. Run Job option is used to manually execute or perform an 
account center job. It is necessary to run the job so that data gets populated in the Oce Account Console. 

To run job: 
1. Right-click the job name and click Run Job. 

            Or, 

                  Select the job name. On the File menu, click Run Job. 

2. Wait till Oce Account Center fields are populated. The job status and remarks are 
displayed in the job details window. 

 
Figure 34: Job details window - Run job status and remarks  

 



 
 

Abacus Data Scheduler 
         48 of 245 
 

Click View Log for log details.  

Preview and Publish Data to the Controller 

The next step is to preview and publish data from the Oce Account Console to the Controller / Oce Account 
Logic.  

Previewing is done to ensure the accuracy of the data. Before you make the data available for the 
Controller / Oce Account Logic, test the data to see if all the fields have valid values. 

Publishing is done to make the data available to the users on the Controller / Oce Account Logic.  

To preview and publish data to controller: 
1. Log on to the Oce Account Console. The last account center job executed through the 

Abacus Data Scheduler appears. 

 
Figure 35: Oce Account Console – Preview button 

The tabular columns display the fields that appear on the data. 

2. Click Preview. The Preview Accounting Dialog webpage appears. 
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Figure 36: Preview accounting dialog webpage 

The webpage displays the Account information sectionas it would appear on the Controller. The field with 
a red dot indicates mandatory or required field.  
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3. Enter the required information in the fields and click Test. A dialog box appears with 
‘OK!’ 

4. Click Close. 

After you use the preview button to make sure all the fields have valid values, you can make the data 
available in Controller / Oce Account Logic. 

 
Figure 37: Oce Account Console – Publish button  

5. Click Publish. A dialog box appears with message “Are you sure you want to make the 
account information dialog available for clients?” 

6. Click OK. A message “Publishing, please wait….” appears on the webpage. It takes 
several seconds to publish the data. Then webpage refreshes indicating that the data is 
published to the Controller / Oce Account Logic. 
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Retrieving log files from the controller 

Use this option to retrieve the log files from the Controller / Oce Account Logic to the Oce Account Console. 

To retrieve log files from the controller: 
1.     Log on to the Oce Account Console. By default, Account fields tab is highlighted. 

 
Figure 38: Oce Account Console – Account data tab 

2.     First click Account data tab and then click Tasks. 

 
Figure 39: Oce Account Console – Account data tab 

3.     Two generated files are displayed. Select Retrieve logdata. 

4.     Under Tasks section, click Edit to modify the schedule. The Edit a task webpage 
appears.  
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Figure 40: Edit a task webpage 

5.     You can retrieve the logdata either manually or as per the schedule.   

 When you select Manual, you must retrieve the log files by clicking Start under 
the Tasks section. 

 When you select Scheduled, the system automatically retrieves log files as per 
the schedule. You could prefer to retrieve the files daily at a particular time or 
weekly on a particular day and time. 

6.     Make the changes and click OK to return to the previous screen. 

7.    Select Retrieve logdata and click Start under Tasks section. 
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The status section may show one of the following:  

 Running : This indicates the task is active. 

 Queued : This indicates the task is in queue. 

 Idle : This indicates the task is inactive. If the status is idle and the last run 
displays the current date and the run time, means the task is completed 
successfully. 

 Error : The task is not completed. The reason for error is displayed in the 
remarks column.  

8.    It may take some time for the status to change.  Click Refresh to refresh the webpage and 
again watch the status. 
The log files are successfully retrieved from the Controller / Account Logic to the Account 
Console. 
 

Reading Account Center Log Files 
This option allows you create a job to read the Account Center log files. Whenever you run the job, based 
on the settings relevant activities are pulled / imported to the Abacus database. 

To read log files: 
1. On the job list, click Account Center Jobs. 

2. To create new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or,  

 On the File menu, click New Job. 

The Create Account Center Job window appears. 
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Figure 41: Create Account Center Job window 

3. In the Create Account Center Job window perform the following: 

a) Enter a job name. 

b) Select Job Type as Read Log Files from the given drop-down list. 

c) Select Server Type as Account Console from the given drop-down list. 
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d) Enter the Server Address. This is the name or IP address of the machine where the 
Oce Account Console is installed. 

e) Enter the Port as 8001. By default account console uses port 8001. If the port is changed 
during the installation, then enter the port number on which the Account console is 
configured. 

4. Click Next to continue. The Choose Read Log Options window appears. 

 
Figure 42: Choose Read Log Options window 
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5. From theTrack Following Jobs section, select the check boxes adjacent to the jobs 
that you want to read from the Account Console log files. 

6. From the Billing pop-up display options section, click to select an appropriate 
option.  

 Select Always to display the Abacus Billing pop-up on the users desktop once 
the job is imported. 

 Select When full information is not entered to display the Abacus billing pop-
up only if the full information is not entered such as Project, Phase etc. 

 If you select Never display billing pop-up, Abacus billing pop-up is not 
displayed for any account center job imported. 

7. From the Use default values section, select the appropriate options: 

 Select the project that you want to go through from the Account Console log file 
from the Project drop-down list. 

 Select the project phase of the selected project that you need to read from the 
Account Console log file from the Phase drop-down list.  

 Select a media from the Media drop-down list.  

 Select a billing code from the Billingcode drop-down list. 

 Enter your comments in the Notes text box. 

 Select a device from the Device drop-down list.  
 
So according to the example, you are creating a job to read Pratt Design projects 
that are in development phase scanned on bond paper and belongs to non-
reimbursable billing code and printed from OCETDS600. 

8. Click Next to continue. The Schedule Job window appears. 
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Figure 43: Schedule job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

9. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Run Job section. 

                           Or, 
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 Clear the Don’t schedule this job check box to schedule the job. Note that the Run Job   
section is now enabled. You may choose to schedule a job at regular intervals or daily or weekly as per 
your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 2 hours, 52 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 9:45:28 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 6:15:00 PM. 

10. Click Next to continue. The Preview Summary window appears. 
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Figure 44: Preview Summary window 

11. Review the account center job details and click Finish. The new job is added in the 
job list under Account Center Jobs. 

Run Job 

The next step is to run the “read log files” job. Run Job option is used to manually execute or perform an 
account center job. It is necessary to run the job so that data gets imported from the Oce Account Console 
to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Oce Account Center log files are interpreted. The job status and remarks are 
displayed in the job details window. 
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Figure 45: Job details window - Run job status and remarks  
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Chapter 4 
Reprodesk Jobs 
In this chapter, you will learn about: 

• Overview 

• Abacus – Repro Desk 4.30.5 Integration 

• Integration by Repro Desk Tool 

• Creating a Reprodesk Import Job 

• Run Job 
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Overview 
This section describes the integration Repro Desk 4.30.5 application with Abacus Data Scheduler.  

To integrate with Abacus you must have Repro Desk 4.30.5 application. This could be installed on any 
machine. Here we assume that you have already installed Repro Desk on your system. 

Repro Desk 4.30.5 is an application used for high speed digital printing. Abacus Data Scheduler helps you 
to track all the activities submitted using Repro Desk.  

Abacus – Repro Desk 4.30.5 Integration 
Abacus and Repro Desk integration can be done in two ways: 

• Integration by Repro Desk Tool 

• Creating and Executing a ReproDesk Import Job 

 
Integration by Repro Desk Tool 
To integrate Repro Desk 4.30.5 with Abacus: 

1. Go to http://support.mirrorplus.com/abacus/abacus_20.asp 

2. Download Reprodesk Work Order Customizer Tool. 

3. Extract ReproDeskWorkOrderGenerator_v2.0.6.exe from the .zip file and double-click to 
Run the application. The Abacus – ReproDesk WorkOrder Integrator window  
appears. 

 
Figure 46:Abacus – ReproDesk WorkOrder Integrator window 

4. Browse and select the ReproDesk HTML Page path. Normally, the path is C:\OCERD 

http://support.mirrorplus.com/abacus/abacus_20.asp�
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5. Browse and select the destination path to create workorder files.  

6. Select Also change the files in the source directory to backup the existing/original file 
and then paste the new file in the source directory.  If cleared, the existing/original file is 
replaced by the new file in the source directory. 

7. Click Install to complete the Abacus – Repro Desk integration. 

8. Open Repro Desk 4.30.5 application.  

f) Click File > New and select Job and then click OK. 

g) Add Files to the new job and select the option button. 

h) Send some test jobs to verify the Abacus – Repro Desk integration. 

 
Figure 47: Repro Desk 4.30.5 – Send Job menu 

9. On the toolbar, click the down arrow next to Send Job icon and select Send Job to from 
the drop-down. The Send Job To window appears.  

 
Figure 48: Send Job To window 
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10. Click to select the Queue option and click OK. The Job Information window appears. 
Scroll down to confirm the Abacus integration. 

 
Figure 49: Job Information window – with Abacus integration 
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Creating a Reprodesk Import Job 
Abacus Data Scheduler is used to create ReproDesk import jobs. This option allows you create a job to 
read the Reprodesk data. 

When you run a ReproDesk import job, all the data is imported from ReproDesk to the Abacus database. 

To create a reprodesk import job: 
1. On the job list, click ReproDesk Jobs. 

2. To create new job: 

 Right-click and select Create New Job. 

Or 

 Click New on the toolbar. 

Or 

 On the File menu, click New Job. 
The Create New Data Import Job window appears. 
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Figure 50: Create New Data Import Job window 

3. Enter a job name in the Job Name text box.  

4. Click  (buddy button) to browse and select the Repro Desk database path. Select the 
.mdx file found on Repro Desk server.  
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5. If the Abacus Data Scheduler is not installed on the same machine where Repro Desk 
Server is installed and you need to schedule this job, Abacus data scheduler service 
requires you to enter valid user information to access the file from the Abacus data 
scheduler service. Click User Authentication. The User Authentication dialog box 
appears. 

 
 

 
Figure 51: User Authentication dialog box 

6. Enter the valid user name and password to access the folder and click Test Connection 
to test the connection. Then click Save to save your settings. 

7. Select the version from the Repro Desk version drop-down list.  

8. Select the jobs to be imported from the Import Job type list. 

9. Select Apply Tracking Rules check box to apply tracking rules.  

10. Select the Log failed records to csv file check box to log failed records to csv file. The 
Create failed log files path is enabled. Provide a path. For example, C:\Documents and 
Settings 

.  

Figure 52: Log failed records to a csv file section 

 
 

11. Click Next to continue. The Field Mappings window appears. 
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Figure 53: Field Mappings window 

12.   In the Field Mappings window, the source fields are mapped to corresponding 
destination fields. Review and change the mapping if required. Column and Row filters 
can be set here depending on the conditions of import. Follow the given procedure: 
 

a)   Select the Source Fields and then click corresponding Column Filter to apply filter. 
The Apply Filter window appears. 
In this example, the above screenshot shows filter condition to be applied for the source 
field – Media. 
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Figure 54: Apply Filter window 

b) Select an Operator from the drop-down list. The available options are =/in, between, !=, 
StartsWith, EndsWith, Contains, <, and >.  

 =/in is used for specifying “if the value is equal to or in” 

 between is used for specifying “if the value is between 2 values” say, 1-100 

 != is used for specifying “if the value is not equal to” 

 StartsWith is used for specifying “if the value starts with” 

 EndsWith is used for specifying “if the value ends with” 

 Contains is used for specifying “if the value contains” 

 < is used for specifying “if the value is lesser than” 

 > is used for specifying “if the value is greater than” 

c) Enter the values for the selected operator and click Add.  

d) Click to select appropriate actions.  

 Click Discard Column option to ignore the column values and use a selected 
default value.   

 Click Discard Row to ignore the whole row.  
In the above example, if the column: Media value is not equal to Vellium, then do 
not import the entire row values. 
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13. Click Apply. The filter conditions are applied in the Field Mappings window. 

14. Click Configure Row Filters in the Field Mappings window to apply row filters. The 
Row Filters window appears. 

 
Figure 55: Row Filters window 

15. Select the appropriate filters and click Close. 
In the above example, if the source column:3 value is equal to inactive, then set the 
project status value as inactive. 
The Field Mappings window appears with the applied row filter details. 
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Figure 56: Field Mappings window 

16. Select the appropriate filters and click Close. In the above example, if the source column: 
3 value is equal to inactive, then set the project status value as inactive. 
The Field Mappings window appears with the applied row filter details. 
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Figure 57: Row filters 

17. Click Next to continue. You may encounter with warning messages such as the following 
screen shots. However it is not mandatory to apply filter conditions for all the columns. 

 
Figure 58: Data Import warning 
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18. Click Yes to continue. The Schedule Job window appears. 

 
Figure 59: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

19. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that the Run Job section is disabled. 

                     Or, 

e) Clear the check box to schedule the job. Note that the Time Interval to Schedule area is 
now enabled. 
You may choose to schedule a job at regular intervals or daily or weekly or monthly as 
per your requirement. 

 Select At Regular Interval check box. Specify the hours, minutes and seconds 
at which the job is automatically executed. For example, every 4 hours, 5 
minutes and 5 seconds. 
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 Or, 

 Select Daily at check box.  Specify the time at which the job is automatically 
executed. For example, daily at 2:34:15 PM. 

 Or, 

 Select Weekly at check box. Click a day and time at which the job is 
automatically executed. For example, every Monday at 5:00:00 PM.  

 Or, 

 Select Monthly at check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

20. Click Finish to continue. The new job is added in the job list under ReproDesk Jobs. 

Run Job 
Run Job option is used to manually execute or perform ReproDesk data import job. When you run a 
ReproDesk import job, all the data is imported from ReproDesk to Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till data is read from the Abacus database and the files are processed. 
The job status and remarks are displayed in the job details window. 
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Figure 60: Job details window - Run job status and remarks  
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Chapter 5 
KIP Jobs 
In this chapter, you will learn about: 

• Overview 

• Populating Fields to KIP Request Application 

• Reading KIP Log Files 
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Overview 
This section describes the integration of KIP Request application with Abacus Data Scheduler.  

To integrate with Abacus you must have KIP Request application. This could be installed on any machine. 
Here we assume that you have already installed KIP on your system. 

How the system works 

Abacus Data Scheduler pushes / populates the data to the KIP Request application. The populated data 
appears as fields on the KIP Request application.  

The KIP Request application is used to submit all the print jobs. The user fills the required fields on the KIP 
Request application before submitting print jobs. This information is stored in log files that are generated by 
KIP Controller. The log files are imported by the KIP Controller. You can schedule an import job in Abacus 
Data Scheduler to retrieve the log files from the KIP Controller. This retrieved data is manipulated by the 
Abacus system for generating reports and billing.  

Following is a pictorial representation of how the system works (For KIP Controller version lower than 6.2): 

 

 

 

 

 

How Abacus system works with KIP Controller version lower than 6.2 

Abacus Data Scheduler supports two types of KIP jobs: 

• KIP Request Integration Job: Job which defines the fields for the KIP Request application 
and pushes the Abacus data to the KIP Controller.  
 

• KIP Data Import Job: Job to read the KIP Controller log files and import activities to the 
Abacus database. 
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Populating Fields to KIP Request Application  
(KIP Controller version lower than 6.2) 

 

Follow this procedure for KIP Controller version lower than 6.2 

 

This option allows defining the billing dialog in Request application and populating Abacus data such as 
users, projects, billing codes, and notes to KIP Request application. 

To populate fields to KIP Request application: 
1. On the job list, click KIP Jobs. 

2. Right-click and select Create New Job. 

                      Or, 

Click New on the toolbar. The Select Job Type window appears. 

 
Figure 61: Select Job Type window 

3. Select job type as KIP Request Integration Job from the Select job type drop-down 
list. The Select KIP Controller version drop-down list appears. 

 
Figure 62: Select KIP Controller version drop-down list 
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4. Select the KIP controller version as Lower than 6.2 from the drop-down list. The 
Request KIP Integration window appears. 

 
Figure 63: Request KIP Integration window (For Lower than 6.2) 

• Enter a job name in the Job name text box.  

• Select Enable this job to push data to KIP Request application check box. The Path to 
KIP Request in file gets enabled. 
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• Click  (buddy button) to browse the path to KIP Request ini file. By default, the path 
to inimod.exe file is populated. 

Select Required Fields section:  You can select the fields that appear on the KIP Request – Submit Print 
Job screen as per your requirement. KIP Request application allows integration of maximum three fields.  

Each field has the following options: 

• Check box – To activate particular fields; select the check box adjacent to each 
field. If you select a field, that particular field is displayed on the KIP Request – 
Submit Print Job screen. 

• Validation – The following are the validation options: 

 Required – Selecting ‘Required’ indicates the validation is mandatory for all 
activities (all print / copy / fax / scan jobs) 

 Optional – Selecting ‘Optional’ indicates validation is not required / not 
mandatory.  

• Display Option – This field indicates how the data is displayed. 

 User/Password Validation – Selecting this indicates the data is displayed only 
to the users with valid password. KIP Request application accepts only users 
with valid and unique password. 

 User/Pin Validation – Selecting this indicates the data is displayed only to the 
users with valid PIN. KIP Request application accepts only users with valid and 
unique PIN. 

 No Validation – Selecting this indicates the data is displayed to all the users 
without any validation. 

 ProjectName – Selecting this indicates the projects are displayed by the project 
names. 

 ProjectNumber – Selecting this indicates the projects are displayed by the 
project numbers. 
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Figure 64: Select Required Fields section 

• User field: 

 Select the User check box to enable the User field. 

 Select an appropriate option from the Validation drop-down list. 

 Enter the text that you want to display in the Display Text text box. 

 Select the display option from the Display Option drop-down list. 

• Project field: Apply the above procedure for the Project field. 

• You can activate either of the two fields – Billing Code or Notes. Apply the same 
method as in User field to select particular options or entering text in the given text box. 

5. Click Next to continue. The Schedule Job window appears. 
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Figure 65: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

6. Perform either of the two activities in the Schedule Import Job window:  

• Select Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Run Job section becomes inactive. 

 Or, 

• Clear the Do not schedule this job check box to schedule the job. Note that the 
Run Job section is now becomes active. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per your requirement. 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 2 hours, 52 minutes 
and 34 seconds. 

 Or, 
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 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 9:45:28 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 6:15:00 PM 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

7. Click Next to continue. The Finish Job window appears. 

 
Figure 66: Finish Job window 
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8. Review the KIP job details and click Finish. The new job is added in the job list under 
KIP Jobs. 

Run Job 

The next step is to run the “populate / push” job. Run Job option is used to manually execute or perform a 
KIP job. It is necessary to run the job so that data gets populated in the KIP Request application. 

To run job: 
1. Right-click the job name and click Run Job 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till KIP Request application fields are populated. 

3. The job status and remarks are displayed in the job details window. 

 
Figure 67: Job details window - Run job status and remarks  
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Transfer settings to KIP Controller (for KIP Controller version lower than 6.2) 

The next step is to transfer data from the KIP Request application to the KIP Controller.  

To transfer settings to the KIP Controller: 
1. Open the KIP Request application.  

 
Figure 68: KIP Request application window 

The highlighted part of the screenshot shows the fields that have been populated in the KIP Request 
application through Abacus Data Scheduler. 

2. On the Option menu, click Prompt Setup. The Prompt Setup Menu appears. 
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Figure 69: KIP Request application – Prompt Setup Menu 

3. Configure the setup by selecting the appropriate check boxes. Select the check box to 
make the fields as drop-down list. Then click OK. 

Note that all the three fields have drop-down list. Verify the data is populated in the drop-down list.  

 
Figure 70: KIP Request application window 

4. On the Transfer menu, click Upload settings to printer. It takes several minutes to 
upload the settings to the printer. KIP Request window appears. 

 
Figure 71: KIP Request window 
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5. Click OK. Once this is done all the Request applications can download the settings from 
the KIP Controller. 
 

Populating Fields to KIP Controller  
(KIP Controller version 6.2 or higher) 

For KIP Controller version 6.2 or higher, Abacus Data Scheduler populates data directly on to the KIP 
Controller.  

 

Follow this procedure for KIP Controller version 6.2 or higher.  

 

To populate fields to KIP Controller: 
1. On the job list, click KIP Jobs. 

2. To create a new job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar. The Select Job Type window appears. 

 
Figure 72: Select Job Type window 

3. Select job type as KIP Request Integration Job from the Select job type drop-down 
list. 

4. Select KIP Controller version from the Select KIP Controller version drop-down list 
appears. 
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Figure 73: Select KIP Controller version drop-down list 

5. Select the KIP controller version as 6.2 or higher from the drop-down list. The Dialog 
window appears. 

 
Figure 74: Dialog window (For 6.2 or higher) 

6. Click here to follow the remaining procedures. 
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Run Job 
The next step is to run the “populate / push” job. Run Job option is used to manually execute or perform a 
KIP job. It is necessary to run the job so that data gets populated in the KIP Request application. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till fields are populated to the KIP Controller. The job status and remarks are 
displayed in the job details window. 

 
Figure 75: Job details window - Run job status and remarks  

The settings are now transferred to the KIP Controller. 

3. Go to C:\Program Files\KIP\Request and open WinReq.ini file. Ensure that Unified 
Accounting is set to 1. 
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If Unified Accounting = 1, settings are downloaded from the KIP Controller. 

If Unified Accounting = 0, settings are downloaded from local system. 

 

4. Open the KIP Request application.  

 
Figure 76: KIP Request application window 

The highlighted part of the screenshot shows the fields that have been populated in the KIP Request 
application through KIP Controller. 

5. On the Option menu, click Prompt Setup. The Prompt Setup Menu appears. 
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Figure 77: Prompt Setup Menu 

6. Select the appropriate check boxes to configure the setup.  

 Select the check box under each section to make the particular field as required 
one. 

 Select the appropriate check boxes below each required fields to make that a 
drop-down list. 

7.  Then click OK. 

Note that all the three fields have drop-down list. Verify the data is populated in the drop-down list.  

 
Figure 78: KIP Request application window 
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Reading KIP Log Files 
This option allows you create a “Pull” job to read the KIP log files. Whenever you run the “Pull” job, all KIP 
activities are imported from KIP log files to Abacus Database. 

To read log files: 
1. On the job list, click KIP Jobs. 

2. To create new job: 

 Right-click and select Create New Job. 

 Or,  

 Click New on the toolbar. 

 Or,  

 On the File menu, click New Job. The Select Job Type window appears. 

 
Figure 79: Select Job Type window 

3. Select job type as KIP Data Import Job from the drop-down list and click Next. The 
Create New Data Import Job window appears. 
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Figure 80: Create New Data Import Job window 

i. Enter a job name in the Job Name text box. 

ii. Browse a local directory for processing. For example: C:\Programs 
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iii. Enter the KIP Controller name or the IP address of the machine where the KIP 
Controller is installed in the given text box. 

iv. Select the Import Job Type from the given drop-down list.  

 Select Read Print Log Files to import the print log files.  

 Select Read Scan Log Files to import the scan log files. 

v. If you need to log failed records to csv file then select the Log failed records to 
csv file check box and provide a path. For example, C:\Programs 

vi. From the Import Jobs section, select the jobs you need to track from the KIP log 
files. 

vii. From the Billing pop-up option section: 

 Click to select Always option if you want to display the Abacus Billing pop-up on 
the users desktop once the job is imported. 

 Click to select the When full information is not entered option if you want to 
display the Abacus billing pop-up only if the full information is not entered such 
as Project, Phase etc. 

 Click to select the Never display billing pop-up option if you do not want the 
Abacus billing pop-up to get displayed for any KIP job imported. 

4. Click Next to continue. The Field Map Page window appears. 
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Figure 81: Field Map Page window 

5. In the Field Map Page window, the source fields are mapped to corresponding destination 
fields. Review and change the mapping if required. Column and Row filters can be set 
here depending on the conditions of import. Follow the procedure: 
 

a) Select the Source Fields and then click corresponding Column Filter to apply filter. The 
Apply Filter window appears. 
In this example, the above screenshot shows filter condition to be applied for the source 
field – Column:6. 
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Figure 82: Apply Filter window 

b) Select an Operator from the drop-down list. The available options are =/in, between, !=, 
StartsWith, EndsWith, Contains, <, and >.  

 =/in is used for specifying “if the value is equal to or in” 

 between is used for specifying “if the value is between 2 values” say, 10-20 

 != is used for specifying “if the value is not equal to” 

 StartsWith is used for specifying “if the value starts with” 

 EndsWith is used for specifying “if the value ends with” 

 Contains is used for specifying “if the value contains” 

 < is used for specifying “if the value is lesser than” 

 > is used for specifying “if the value is greater than” 

c) Enter the values for the selected operator and click Add.  

d) Select the appropriate actions.  
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e)  Click Discard Column to ignore the column values and enter a default value in the Use 
Default Value text box to use a selected default value or click Discard Row to ignore 
the whole row. 

In the above example, if the column: 6 value is in between 10 and 20, then do no import the entire row. 

f) Click Apply. The filter conditions are applied in the Field Map Page window. 

6. Click Configure Row Filters to apply row filters. The Row Filters window appears. 

  
Figure 83: Row Filters window 

7. Select the appropriate filters and click Close. 

In the above example, if the source column:5 value is equal to 10, then set the Billing Code value as Non-
Reimbursable. The Field Map Page window appears with the applied row filter details. 
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8. Click Next to continue. You may encounter with warning messages. However, it is not 
mandatory to apply filter conditions for all the columns. 

9. Click Yes to continue. The Schedule Job window appears. 

 
Figure 84: Schedule Import Job window 

Schedule Import Job window is used to automatically run the activity at specified intervals. If you choose 
not to schedule a job, you can manually execute the job using Run Job option. 

10. Perform either of the two activities in the Schedule Import Job window:  

• Select Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Run Job section becomes inactive. 

 Or, 
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• Clear the Do not schedule this job check box to schedule the job. Note that the 
Run Job section is now becomes active. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per needs. 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 2 hours, 52 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 9:45:28 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 6:15:00 PM 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

11. Click Next to continue. The Finish Import Job window appears. 
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Figure 85: Finish Job window 

12. Review the KIP job details and click Finish. The new job is added in the job list under 
KIP Jobs. 
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Run Job 

The next step is to run the “read log files” job. Run Job option is used to manually execute or perform a KIP 
job. It is necessary to run the job so that data gets imported from the KIP Controller to the Abacus 
database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till KIP Controller log files are processed. The Run Options window appears. 

 
Figure 86: Run Options window 

3. Select one of the following options: 

 Select Run All to execute all the files. 

 Select Since Last Execution to execute all the pending files since last 
execution. 

 Select Dates to execute all the files between the mentioned Start date and End 
date. 

 Select Selected Files and choose the files to be executed. 

4. Click Run. The job status and remarks are displayed in the job details window. 
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Figure 87: Job details window - Run job status and remarks  
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Chapter 6 
MetaPrint Jobs 
In this chapter, you will learn about: 

• Overview 

• Direct Integration 

• Integrating MetaPrint Log Files with Abacus Data Scheduler 

• Creating a MetaPrint Job 

• Run Job 
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Overview 
MetaPrint server integration can be done in two ways: 

• Direct Integration 

• MetaPrint Log Files Integration 
 

Direct Integration 
The Direct integration allows tracking prints from MetaPrint Server on the fly and updates to Abacus 
database through Abacus Communication server. 

 

Abacus billing pop-up is a pre-requisite for direct integration.  

 

MetaPrint 2.1.3 – Abacus Server Direct Integration 
1. Open MetaPrint Server Application.  

2. Click the arrow next to Tools and then click Abacus Preferences. The Abacus 
MetaPrint Integration Settings window appears. 

 

 
Figure 88: Abacus MetaPrint Integration Settings 

3. Enter the server address in the Server Address text box. This is the name or IP address 
of the machine where the Abacus communication server is installed.  
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4. Enter the Server Port as 8000. By default Abacus communication server port is set to 
8000. If port is changed during the installation, then enter the port number on which the 
Abacus communication server is configured. 

5. In the Build Activity for each section: 

 Click Build Activity for each Job to select the Activity to create each MetaPrint 
job.  

 Click Build Activity for each File to select the Activity to create each file in the 
job. 

6. Select the tracking options.  

7. Click Save.  

8. Click the arrow next to Tools and then click Preferences. The Preferences window 
appears. 

 
Figure 89: Preferences window 

9. Under Preferences section ensure that Prompt Accounting For Queue Jobs and 
Enable External Tracking Plugins check boxes are selected. 
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10. Click OK.  

11. Explore C:\Program Files > MetaPrint Server > Plugins and confirm 
AbacusSTForMP.dll and AbacusSTForMP.ini files are present. 

12. Copy accounting.jss file in MetaPrint Server root folder. You can find accounting.jss 
file in C:\Program Files > MetaPrint Server. 

13. You can test the MetaPrint-Abacus integration by printing some test jobs. To print: 

a) Open MetaPrint Server application.  

b) Click Print on the main toolbar and send job to Printer. The Job Accounting 
Information window appears. 

 
Figure 90: Job Accounting Information window – with Abacus integration 



 
 

Abacus Data Scheduler 
         107 of 245 
 

MetaPrint 2.1.3 – Abacus Client Integration 
1. Open MetaPrint Client Application. 

2. Click the arrow next to Tools and then click Preferences. The Preferences window 
appears. 

 
Figure 91: Preferences window 

3. Under Preferences section ensure that Prompt Accounting For Queue Jobs check 
box is selected.  

4. Click OK. 

5. Copy accounting.jss file in MetaPrint Client root folder. You can find accounting.jss file 
in C:\Program Files > MetaPrint Client > metaprint_share. 

                    Or, 

                    You can integrate through global .ini file. Follow these steps: 

6. Explore C:\Program Files > MetaPrint Client > metaprint_share folder. 
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7. Ensure that metaprint_share folder is shared.  

8. Point MetaPrint Client to MetaPrintSettings.ini file. 

9. Configure MetaPrintSettings.ini file for MetaPrint Client Integration. 

 
Figure 92: MetaPrintSettings.ini file – Configuration 

10. Enter AccountingFile=\\ [IP Address of Server]\metaprint_shared\Accounting.js.  

11. Save the changes and close the file. 
 

Integrating MetaPrint Log Files with Abacus Data Scheduler 
This integration allows importing the activities data from MetaPrint Log (CSV) files. 

To integrate MetaPrint log files with Abacus Data Scheduler: 

Install Abacus Data Scheduler application. The Abacus Data Scheduler application need not be on the 
same machine where you installed the MetaPrint server. The Data Scheduler can be installed on any 
machine. 

1. Open MetaPrint Server Application. 

2. Click the arrow next to Tools and then click Preferences. The Preferences window 
appears. 
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Figure 93: Tools menu 

3. Select Application and click Logging from the Preferences window.. 

 
Figure 94: Preferences window 

4. In the Job Logging section, select Log Print Info to file check box. 

  
Figure 95: Job Logging section 

5. Click OK. 

The MetaPrint server application generates the CSV log files. These files will be located in C:\Program 
Files\ MetaPrint Server\Logs directory. Print some test jobs and make sure the log files are generated. 
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Creating a MetaPrint Job 
Abacus Data Scheduler is used to create MetaPrint Import Jobs. This option allows you create a job to read 
the MetaPrint log files. 

When you run a MetaPrint job, all the data is imported from MetaPrint log files to the Abacus database. 

To create a MetaPrint job: 
1. On the job list, click MetaPrint Jobs. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job.  
The Create New Data Import Job window appears. 
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Figure 96: Create New Data Import Job window 

3. In the Create New Data Import Job window: 

a) Enter the job name in the Job Name text box. 
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b) Click  (buddy button) to browse and select the MetaPrint log directory path. It is 
normally, C:\Programs 

c) If the Abacus Data Scheduler is not installed on the same machine where MetaPrint 
Server is installed and you need to schedule this job, Abacus data scheduler service 
requires you to enter valid user information to access the file from the Abacus data 
scheduler service. Click User Authentication. The User Authentication dialog box 
appears. 

 

 
Figure 97: User Authentication dialog box 

d) Enter the valid user name and password to access the folder and click Test Connection 
to test the connection. Then click Save to save your settings. 

e) Select the version from the Metaprint Version drop-down list.  

f) Select the jobs to be imported from the Import Job type list. 

g) From the Billing pop-up option section: 

 Click to select Always option if you want to display the Abacus Billing pop-up on 
the users desktop once the job is imported. 

 Click to select the When full information is not entered option if you want to 
display the Abacus billing pop-up only if the full information is not entered such 
as Project, Phase etc. 

 Click to select the Never display billing pop-up option if you do not want the 
Abacus billing pop-up to get displayed for any MetaPrint job imported. 

h) Select Apply Tracking Rules check box to apply tracking rules.  

i) Select the Log failed records to csv file check box to log failed records to csv file. The 
Create failed log files path is enabled. Provide a path. For example, C:\Programs. 
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4. Click Next. The Field Mappings window appears. 

 
Figure 98: Field Mappings window 

5. In the Field Mappings window, the source fields are mapped to corresponding 
destination fields. Review and change the mapping if required. Column and Row filters 
can be set here depending on the conditions of import. Follow the given procedure to set 
the condition: 
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j) Select the Source Fields and then click corresponding Column Filter to apply filter. The 
Apply Filter window appears. 
In this example, the above screenshot shows filter condition to be applied for the source 
field – Jobname. 

 
Figure 99: Apply Filter window 

k)   In the Condition section, select an Operator from the drop-down list. The available 
options are =/in, between, !=, StartsWith, EndsWith, Contains, <, and >.  

 =/in is used for specifying “if the value is equal to or in” 

 between is used for specifying “if the value is between 2 values” say, 1-100 

 != is used for specifying “if the value is not equal to” 

 StartsWith is used for specifying “if the value starts with” 

 EndsWith is used for specifying “if the value ends with” 

 Contains is used for specifying “if the value contains” 

 < is used for specifying “if the value is lesser than” 

 > is used for specifying “if the value is greater than” 
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l) Enter the values for the selected operator and click Add.  

m) In the Action section, select the appropriate actions.  

 Click Discard Column to ignore the column values and enter a default value in 
the Use Default Value text box to use a selected default value.   

 Click Discard Row to ignore the whole row.  
In the above example, if the column: Jobname value is not equal to Print, then do 
no import the entire column values. Instead use the default value = print. 

6. Click Apply. The filter conditions are applied in the Field Mappings window. 

7. Click Configure Row Filters to apply row filters. The Row Filters window appears. 

 
Figure 100: Row Filters window 
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8. Select the appropriate filters and click Close. In the above example, if the source 
column:3 value is equal to inactive, then set the project status value as inactive. 
The Field Mappings window appears with the applied row filter details. 

9. Click Next to continue. You may encounter with warning messages such as the following 
screen shots. However it is not mandatory to apply filter conditions for all the columns. 

 
Figure 101: Data Import warning 

10. Click Yes to continue. The Schedule Job window appears. 

 
Figure 102: Schedule Job window 
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Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

11. Perform either of the two activities in the Schedule Import Job window:  

• Select Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Run Job section becomes inactive. 

 Or, 

• Clear the Do not schedule this job check box to schedule the job. Note that the 
Run Job section is now becomes active. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per needs. 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 2 hours, 52 minutes 
and 34 seconds. 

 Or,   

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 9:45:28 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 6:15:00 PM 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

13. Click Next to continue. The Finish Job window appears. 
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Figure 103: Finish Job window 

14. Review the import job details and click Finish. The new job is added in the job list under 
MetaPrint Jobs. 
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Run Job 
Run Job option is used to manually execute or perform a MetaPrint import job. It is necessary to run the job 
so that data gets imported from the MetaPrint log files to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till MetaPrint log files are processed. The Run Options window appears. 

 
Figure 104: Run Options window 

3. Select an appropriate run option. 

• Click Run All to execute all the files.  

• Click Since Last Execution to execute all the pending files since last execution. 

• Click Dates to execute all the files between the Start date and End date. 

• Click Selected Files and choose the files to be executed. 

4. Click Run. The job status and remarks are displayed in the job details window. 
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Figure 105: Job details window - Run job status and remarks 
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Chapter 7 
Abacus Audit Jobs 
In this chapter, you will learn about: 

• Overview 

• Creating Abacus Audit Job 

• Run Job 
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Overview 
You can set auditing rules for events like device tracking, data import jobs, billing pop up and other Abacus 
services. The auditing settings that you choose for the event categories define your auditing policy.  
 
By defining auditing settings for specific event categories, you can create an auditing policy that suits the 
needs of your organization.  

Creating Abacus Audit Jobs 
To create an Abacus audit job: 

1. On the job list, click Abacus Audit Jobs. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job. 
 
The Audit Event Manager window appears. 
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Figure 106: Audit Event Manager window 

3. Click Configuration on the left-pane. The Configure Audit Settings screen appears in 
the right-pane. 
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Figure 107: Audit Event Manager – Configuration  

4. Follow the given procedure to configure the email.  

a) Enter the SMTP server name for delivering the e-mail messages in the Smtp Server text 
box. 

b) Enter the e-mail address in the Email Address text box. 

c) Enter the e-mail server port in the Email Server Port text box. Default port to which 
outgoing mail server accepts e-mail messages is 25. 

d) Enter a valid user name in the User text box. 

e) Enter a valid password in the Password text box. 

f) Enter the location of server on the network in the Location Name text box. 

g) Select an appropriate e-mail application from the Send Email using drop-down list.  

h) Click Save Settings to save the e-mail configuration settings. 
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i) To send test e-mail, enter your e-mail id in the Send Test Email To text box and click 
Send to send a test e-mail. 

j) Enter the number of hours to receive consolidated e-mail alerts at specified intervals in 
the given text box. 

5. Click Device Tracking in the left-pane. The Audit Settings screen appears in the right-
pane. 

 
Figure 108: Audit Event Manager – Device Tracking 

6. You can track devices based on the rules you specify.  
 

a) Enter the number of hours in the text box. This enables to track the device if the device is 
idle for specified number of hours. 

b) Select or clear the Weekends check box. If selected, the tracking does not apply for 
weekends.  This indicates that the device is not tracked during weekends even if the 
device is idle. 

c) Select the required Action Settings. This specifies what action needs to be done if the 
device is idle for specified number of hours. 
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 To send tracking activities through e-mail, select Send Email check box and 
enter the e-mail address to which tracking activities would be sent. 

 Select the Restart Service check box to re-start the tracking service. 

 Select Active check box to apply the tracking rules for all the devices.  

d) To apply different tracking rules for each device, right-click Device Tracking in the left-
pane and select Add New. The Add New Item window appears. 

 
Figure 109: Add New Item window 

e) Select the devices and click Add. All the selected devices are added under Device 
Tracking in the left-pane. 

 

 
 
 

f) You can select each device and set the tracking rules based on your requirement. 

g) Once you set the device tracking rules, click Save. 
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7. Click Data Import Jobs in the left-pane. The Audit Settings screen appears in the right-
pane. 

 
Figure 110: Audit Event Manager – Data Import Jobs 

8. Specify audit settings for data import jobs as per your requirement.  

9. Once you set the rules for data import jobs, click Save. If any failure occurs in any data 
import jobs necessary action is taken based on the audit settings. 

10. Click Billing Pop-up in the left-pane. The Audit Settings screen appears in the right-
pane. 
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Figure 111: Audit Event Manager – Billing Pop-up 

11. Specify audit settings for billing pop-up as per your requirement.  

12. Once you set the rules for billing pop-up, click Save. If the server fails to send activities to 
billing pop-up, necessary action is taken based on the audit settings. 

13. Click Service Health on the left-pane. . The Audit Settings screen appears in the right-
pane. 
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Figure 112: Audit Event Manager – Service Health 

14. Specify audit settings for service applications – Abacus Communication Server, Abacus 
Track Server, and Abacus Scheduler Service.  

15. Once you set the rules for service applications, click Save. If any failure occurs in any 
service applications, necessary action is taken based on the audit settings. 

16. Click OK. The new job is added in the job list under Abacus Audit Jobs. 

 Run Job 
Run Job option is used to manually execute or perform Abacus audit job.  

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus audit jobs are processed. 
The job status and remarks are displayed in the job details window. 
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Figure 113: Job details window - Run job status and remarks  
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Chapter 8 
Data Export Job 
In this chapter, you will learn about: 

• Overview 

• Creating a Data Export Job 

• Run Job 
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Overview 
Data export jobs are used to export data from the Abacus database to .csv or .txt format. 

Creating a Data Export Job 
To create a data export job: 

1. On the job list, click Data Export. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job. 
 
The Enter Data Export Job Details window appears. 

 
Figure 114: Enter Data Export Job Details window 
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3. Under Job Details section: 

a)   Enter the job name in the Job Name text box.  

b)   Select the data to be exported from the Export Data drop-down list. The options are 
Projects and Activities. If we select Projects, the Activity Pricing section is not 
activated, but once you select the Activity, the Activity Pricing section becomes 
activated and you can include pricing with activity as per your requirement.   

4. Click Next to continue. The Export Option Page appears. 

 
Figure 115: Export Option Page 

5. You can set the export criteria in this window.  

a)   Select the required column names.  
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b)   Click Select All to select all the column names or click Clear All to clear all the column 
names.  

c)   Select a column name and click Move Up or Move Down to change its order. 

d)   You can sort all export fields using one column as sorting key.  

e)   Select the column that you want to sort from the Column drop-down list.  

f)   Select the order from the Sort drop-down list to sort the column order either in A-Z 
pattern or Z-A pattern. 

6. Click Next to continue. The Export Setting Page appears. 

 

Figure 116: Export Settings Page 
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a)  Click  (buddy button) and browse the path where you want to store the exported file. 

b)  Enter a file name in the File Name text box. 

c) Select the file format from the File Format drop-down list. The options are: the Text File 
and the MDB File. Please note that the extension of the file name will depend on the file 
format selection. Example: If the File Format selected is MDB File, then the file name 
would be Activity Data.mdb and selecting the MDB File disable the Export Options 
section. 

d)   If you select the Text File as the File Format then the Export Options section is 
enabled, then select appropriate export options. Rows in the data stream are separated 
by row delimiters; within each row, individual cell values are separated by column 
delimiters. 

e)   Select a Column Delimiter from the drop-down list. 

 Select CSV Delimiter to delimit columns with a comma. Here comma is used as 
separator between columns. The data export output will be in CSV format (.csv)  

 Use TAB Delimiter option to delimit columns with a TAB. Here TAB is used as 
separator between columns. The data export output will be in Text format (.txt) 

f)   To replace the column delimiter with spaces, select the Replace Column Delimiter 
with spaces check box. 

g)   Select or clear Column Headers check box. If selected, the column headers are 
exported in the file. 

h)   Select a Row Delimiter from the drop-down list. Select New Line to delimit rows in the 
data export to start in a new line. Here the end of each row is marked by a new line. 

i)   Apply filter if required. Select or clear the Export All Activities check box. Selecting the 
check box allows you to export all the activities as soon as it is finished. Clearing the 
check box activates the Start Date and End Date drop-down list that allows you to 
select the particular dates when you want to export the given activities.  

j)   Select the Auto Billing Information check box to automate the billing information. 
Once you select the check box and click Next. The Configure Billing Schedule 
window appears. 
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Figure 117: Configure Billing Schedule window 

7. Configure the billing schedule. 

a)   Select the billing period to send the billing information within a specific time period from 
the Billing Period drop-down list. 

b)   Enter the client name in the Client Name text box. 

c)   Schedule the billing file export if required.  

 Select or clear the Send via email check box. Selecting the check 
box activates the underneath fields where you have to specify the e-
mail server details, if you want to send the billing information via e-
mail. Clearing the checkbox disabled the underneath fields. 

 Similarly, select or clear the Send via ftp check box. Selecting the 
check box activates the underneath fields where you have to specify 
the ftp details, if you want to send the billing information via ftp. 
Clearing the checkbox disabled the underneath fields.  
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If you select Projects from the Export Data drop-down list, in the Export Settings 
Page Active Projects Only check box appears. You can select or clear the check box 
as per your requirement. If selected, only the active projects are exported. 

8. Click Next to continue. The Schedule Job window appears. 

 
Figure 118: Schedule Job window 

Schedule Import Job window is used to automatically run the activity at specified intervals. If you choose 
not to schedule a job, you can manually execute the job using Run Job option. 

9. Perform either of the two activities in the Schedule Import Job window:  

• Select Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Run Job section becomes inactive. 

 Or, 
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• Clear the Do not schedule this job check box to schedule the job. Note that the 
Run Job section is now becomes active. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per needs. 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 2 hours, 52 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 9:45:28 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 6:15:00 PM 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

10. Click Next to continue. The Finish Job window appears. 
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Figure 119:  Finish Job window 

11. Preview the export job details and click Finish to save the job. The new job is added in 
the job list under Data Export. 
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Run Job 
Run Job option is used to manually execute or perform Abacus data export job.  

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till data is read from the Abacus database and the files are processed. 
The job status and remarks are displayed in the job details window. 

 
Figure 120: Job details window - Run job status and remarks  
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Chapter 9 
Abacus IPlot Jobs 
In this chapter, you will learn about: 

• Overview 

• Creating IPlot Job 

• Run Job 
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Overview 
This section describes the integration IPlot Jobs with Abacus Data Scheduler This information is stored in 
log files, which are imported by IPlot. You can schedule an import job in Abacus Data Scheduler to retrieve 
the log files from the IPlot. This retrieved data is manipulated by the Abacus system for generating reports 
and billing.  

Creating IPlot Job 
To create an IPlot job: 

1. On the job list, click IPlot Jobs. 

2. To create a new job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar. 

Or, 

 On the File menu, click New Job. 
 
The Create New Data Import Job window appears. 
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Figure 121: Create New Data Import Job window 

3. In the Create New Data Import Job window: 

a) Enter the job name in the Job Name text box. 

b) Click  (buddy button) to browse and select the IPlot Log File path.  

c) Click User Authentication to authenticate the user. The User Authentication dialog 
box appears. 
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Figure 122: User Authentication dialog box 

d) Enter the valid user name and password to access the folder and click Test Connection 
to test the connection. Then click Save to save your settings. 

e) Under the Billing Popup option section: 

 Select the Never Display Billing popup for these jobs section, if you do not 
want to display the billing popup for the jobs. 

 Select the Apply Tracking Rules if you want to apply the tracking rules for the 
jobs. 

f) Under Activity Options section: 

 Select the Build Activity Per Job check box if you want to track one activity for 
a job. 

 Select Build Activity Per Page check box if you want to build one activity total of 
all jobs per page. 

g) Under Import Options section: 

 Select the Track Print to file jobs check box to track print for file jobs. 

 Select Ignore jobs with 0 length and 0 width check box to ignore the jobs with 
the 0 length and 0 width. 

h) Select the Log failed records to csv file check box to log failed records to csv file. The 
Create failed log files path is enabled. Provide a path.  

4. Click Next. The Choose Read Log Options window appears. 
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Figure 123: Choose Read Log Options 

5. Select a device that you want to get associated with the printer from the Device drop-
down list. 

6. From the Use default values section: 
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a) Select the project that you want to go through from the IPlot log file from the Project 
drop-down list. 

b) Select the project phase of the selected project that you need to read from the IPlot log 
file from the Phase drop-down list.  

c) Select a media from the Media drop-down list.  

d) Select a billing code from the Billingcode drop-down list. 

e) Enter your comments in the Notes text box. 

7. Click Next to continue. The Schedule Job window appears. 

 
Figure 124: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 
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8. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Run Job section. 

                    Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Run Job 
section is now enabled. You may choose to schedule a job at regular intervals or daily or 
weekly as per your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 10:00:00 AM. 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

9. Click Next to continue. The Finish Job window appears. 
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Figure 125: Finish Job window 

10. Click the Advance Option if you want to configure pre and post program execution. The 
Configure Pre & Post Program Execution dialog box appears. 
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Figure 126: Configure Pre & Post Program Execution dialog box 

11. Select the Pre Job Execution Option check box to execute the job prior to this job. 

 Click the External Program and select the program that you want to execute 
prior to this job. 

 Click the Abacus Job and select the job from the given drop-down list. 

12. Select the Post Job Execution Option check box to execute the job after execution of 
this job. 

 Click the External Program and select the program that you want to execute 
after this job. 

 Click the Abacus Job and select the job from the given drop-down list. 

13. Click Finish to save the IPlot job. The new job is added in the job list under IPlot Jobs. 
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Run Job 

The next step is to run the “read log files” job. Run Job option is used to manually execute or perform an 
IPlot job. It is necessary to run the job so that data gets imported from the IPlot to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till IPlot log files are interpreted. The job status and remarks are displayed in the job 
details window. 

 
Figure 127: Job details window - Run job status and remarks  
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Chapter 10 
Fiery Jobs 
In this chapter, you will learn about: 

• Overview 

• Creating Fiery Jobs 

• Run Job 
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Overview 
This section describes the integration of Fiery Controller with Abacus Data Scheduler. When the job runs 
the Data Scheduler connects the fiery controller using the provided credentials and read the print 
information from the Fiery database. 

Creating Abacus Fiery Jobs 
To create an Abacus Fiery job: 

1. On the job list, click Fiery Jobs. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job. 
 
The Create New Data Import Job window appears. 
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Figure 128: Create New Data Import Job window 

3. Enter the job name in the Job Name text box. 

4. In the Controller Details section: 

a) Enter the IP address in the Fiery Controller text box. 

b) Enter the user name in the User Name text box. 

c) Enter a password in the Password text box. 

5. Select a device name from the Select Device Name drop-down list. 

6. In the Billing Popup Option section: 

 Select Never Display Billing popup for these jobs check box, if you do not 
want to display the billing popup for the jobs. 
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 Select Apply Tracking Rules check box to apply tracking rules for the jobs. 

7. Click Next to continue. The Default options window appears. 

 
Figure 129: Default Options window 

The Default Options window allows you to set the default values for the jobs. 

8. Enter the default width and length in inches in the Width and Length text boxes 
respectively. 

9. Under Use default values section: 

a) Select a project that you want to go through from the Fiery log file from the Project drop-
down list. 

b) Select the project phase of the selected project that you need to read from the Fiery log 
file from the Phase drop-down list. 
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c) Select a media from the Media drop-down list.  

d) Select a billing code from the Billingcode drop-down list. 

e) Enter your comments in the Notes text box. 

14. Click Next to continue. The Schedule Job window appears. 

 
Figure 130: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

15. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Run Job section. 
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                      Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Run Job section is now 
enabled. You may choose to schedule a job at regular intervals or daily or weekly as per your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

16. Click Next to continue. The Finish Job window appears. 



 
 

Abacus Data Scheduler 
         157 of 245 
 

 
Figure 131: Finish Job window 

17. Click the Advance Option if you want to configure pre and post program execution. The 
Configure Pre & Post Program Execution dialog box appears. 
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Figure 132: Configure Pre & Post Program Execution dialog box 

18. Select the Pre Job Execution Option check box to execute the job prior to this job. 

 Click the External Program and select the program that you want to execute 
prior to this job. 

 Click the Abacus Job and select the job from the given drop-down list. 

19. Select the Post Job Execution Option check box to execute the job after execution of 
this job. 

 Click the External Program and select the program that you want to execute 
after this job. 

 Click the Abacus Job and select the job from the given drop-down list. 

20. Click Finish to save the Fiery job. The new job is added in the job list under Fiery Jobs. 
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Run Job 

The next step is to run the “read log files” job. Run Job option is used to manually execute or perform an 
Fiery job. It is necessary to run the job so that data gets imported from the Fiery to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Fiery log files are interpreted. The job status and remarks are displayed in the job 
details window. 

 
Figure 133: Job details window - Run job status and remarks  
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Chapter 11 
Central Server  
We can perform following tasks through Central Server: 

• Import Data 

• Sync Data 

In this chapter, you will learn about: 

• Overview 

• Creating Job 

• Schedule Job 

• Run Job 
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Overview of Data Import CO  
Data Import CO jobs are created to import the updated projects and phases from the Central database 
server to the Abacus database. 

The Central database server settings are done by your reprographics provider using the Abacus Manager 
application. 

Data Scheduler is used to create, schedule and execute the data import CO jobs. 

Creating a Data Import CO Job 
To create a data import CO job: 

1. On the job list, click Data Import CO. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job.  

The new job is added in the job list under Data Import CO. 

Scheduling Data Import CO Job 
Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option.  

To schedule data import CO job: 
1. In the job list, right-click the data sync job name under Data Import CO and select 

Modify Schedule. The Schedule Job window appears. 
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Figure 134: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

2. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Time Interval to Schedule 
section. 

                    Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Time Interval to Schedule 
section is now enabled. You may choose to schedule a job at regular intervals or daily or weekly as per 
your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

 Or, 
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 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

3. Click Finish to complete scheduling the data import CO job. 
 
 

Run Job 
Run Job option is used to manually execute or perform a data import CO job. It is necessary to run the job 
so that projects and phases are imported from the central database server to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 

  
Figure 135: Job details window - Run job status and remarks 

 

 



 
 

Abacus Data Scheduler 
         164 of 245 
 

Overview of Data Sync 
Data sync jobs are created to sync the Abacus database to the Central database server. This is used to 
transfer all the activities from the local database to the central database server. This process helps to 
maintain consistency and keep the data up-to-date so that both repositories contain the similar information. 

The Central database server settings are done by your reprographics provider using the Abacus Manager 
application. 

Data Scheduler is used to create, schedule and execute the data sync jobs. 

Creating a Data Sync Job 
To create a data sync job: 

1. On the job list, click Sync Data. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job.  

The new job is added in the job list under Data Sync Jobs. 
 

Scheduling Data Sync Job 
Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option.  

To schedule data sync job: 
1. In the job list, right-click the data sync job name under Data Sync Jobs and select 

Modify Schedule. The Schedule Job window appears. 
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Figure 136: Schedule Import Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

2. Perform either of the two activities in the Schedule Import Job window:  

• Select Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Time Interval to Schedule section becomes 
inactive. 

 Or, 

Clear the Do not schedule this job check box to schedule the job. Note that the Time Interval to 
Schedule section now becomes active. You may choose to schedule a job at regular intervals or daily or 
weekly or monthly as per needs. 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 2 hours, 45 minutes 
and 0 seconds. 
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 Or,  

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 1:36:59 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 1:36:59 PM 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

3. Click Finish to complete scheduling the data sync job.  

Run Job 
Run Job option is used to manually execute or perform a data sync job. It is necessary to run the job so that 
data gets synchronized from the Abacus database to the central database server. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 
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Figure 137: Job details window - Run job status and remarks 
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Chapter 12 
Active Directory Jobs 
In this chapter, you will learn about: 

• Overview 

• Creating Active Directory Jobs 

• Run Job 
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Overview 
This section describes the integration of Active Directory with Abacus Data Scheduler. To import job the 
user needs to map fields to import the list of users from the active directory. For successful completion of 
task the user has to provide the server name, the domain name, the valid user id, and the password 
respectively in the given fields. The user can also apply filter query to retrieve user details. 

Creating an Active Directory Job 
To create an Active Directory job: 

1. On the job list, click Active Directory. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job.  
The Enter Data Import Job Details window appears. 
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Figure 138: Create Job window 

3. Under Job Details section: 

a) Enter the job name in the Job Name text box. 

b) Select the type of import from the Import Type drop-down list. 

4. Under LDAP section: 

a) Enter the server name in the Server text box. 

b) Enter the domain name in the Domain text box. 

c) Enter a valid user name and password in the User and Password text box respectively. 

d) Select the Filter Query check box to enable the text area under Filter Query and enter 
the query to filter if required. 

5. Click Next to continue. The Filed Mappings window appears. 
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Figure 139: Options window 

6. In the Field Mappings window, the source fields are mapped to corresponding 
destination fields. Review and change the mapping if required. Column and Row filters 
can be set here depending on the conditions of import. Follow the procedure: 
 
Select the Source Fields and then click corresponding Column Filter to apply filter. The 
Apply Filter dialog box appears. 
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Figure 140: Apply Filter dialog box 

  

7. Select an Operator from the drop-down list. The available options are:  =/in, between, 
!=, StartsWith, EndsWith, Contains, <, and >.  
 

 “=/in” is used for specifying “if the value is equal to or in” 

 “between” is used for specifying “if the value is between 2 values say, 1-100” 

 “!=” is used for specifying “if the value is not equal to” 

 “StartsWith” is used for specifying “if the value starts with” 

 “EndsWith” is used for specifying “if the value ends with” 

 “Contains” is used for specifying “if the value contains” 

 “<” is used for specifying “if the value is lesser than” 

 “>” is used for specifying “if the value is greater than” 

8. Enter the values for the selected operator and click Add.  
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9. Select appropriate actions.  

 Click Do not Import Column data option to ignore the column values and use a 
selected default value.   

 Or, 

 Click Do not Import Row option to ignore the whole row.  
In the above example, if the column: 3 value is equal to inactive, then do not 
import the entire row. 

10. Click Apply. The filter conditions are applied in the Field Mappings.  

11. Click Configure Row Filters to apply the row filters. The Row Filters dialog box 
appears. 

 
Figure 141: Row Filters dialog box 
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e) Select the appropriate filters. 

f) Click Close. In the above example, if the source column: 3 value is equal to inactive, 
then set the project status value as inactive. The Field Mappings window appears with 
the applied row filter details. 

12. Click Next to continue. You may encounter with warning messages. However, it is not 
mandatory to apply filter conditions for all the columns. 

 
Figure 142: Data Import Warning dialog box 

13. Click Yes to continue. The Schedule Job window appears. 
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Figure 143: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

14. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Time Interval to Schedule 
section. 

                    Or, 
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Clear the Don’t schedule this job check box to schedule the job. Note that the Time 
Interval to Schedule section is now enabled. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

15. Click Next to continue. The Finish Job window appears. 
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Figure 144: Finish Job window 

16. Click Finish to save the import job. The new job is added in the job list under Active 
Directory Jobs. 

Run Job 
Run Job option is used to manually execute or perform a Active Directory job. It is necessary to run the job 
so that data gets imported from the Active Directory to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 
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Figure 145: Job details window - Run job status and remarks 
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Chapter 13 
HP DesignJet Jobs 
In this chapter, you will learn about: 

• Overview 

• Creating HP DesignJet Jobs 

• Run Job 
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Overview 
This section describes the integration of HP Design Jet with Abacus Data Scheduler. To import job the user 
needs to create HP integration job. The user can import data from controller as well as from file as per their 
requirement. It is an optional job. When Abacus failed to track the HP Design Jet then you can configure 
this job to retrieve the information from the HP Design Jet controller. 

Creating a HP DesignJet Job 
To create a HP DesignJet job: 

1. On the job list, click HP DesignJet. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar. 

 Or, 

 On the File menu, click New Job.  
The Create Job window appears. 
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Figure 146: Create Job window 

3. Under Job Details section: 

a) Enter the job name in the Job Name text box. 

b) Enter the device model name in the Device Model text box. 

4. Under Import from controller section: 

a) Enter the IP address in the IP Address text box. 

b) Select the Import from file check box if you want to import the job from the file. 
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c)  Click   (buddy button) and select the file residing path. 

d)   If the Abacus Data Scheduler is not installed on the same machine where HP DesignJet 
Server is installed and you need to schedule this job, Abacus data scheduler service 
requires you to enter valid user information to access the file from the Abacus data 
scheduler service. Click User Authentication. The User Authentication dialog box 
appears. 

 

 
Figure 147: User Authentication dialog box 

e)  Enter the user name and password to access the folder and click Test Connection to 
test the connection. Then click Save to save your settings. 

5. Click Next to continue. The Options window appears. 
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Figure 148: Options window 

6. Select the device from the Select Device drop-down list.  

7. Select either Push Billing popup for these jobs check box or select the default data 
from the Default Data section. 

a) Select Push Billing popup for these jobs check box to display the billing popup after 
completion of each job. 
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b) Select Apply Tracking Rules check box to apply the tracking rules for each job. 

8. Under Default Data section: 

a) Select a project that you want to go through from the Project drop-down list. 

b) Select the project phase of the selected project that you need to read from the Phase 
drop-down list. 

c) Select a media from the Media drop-down list.  

d) Select a billing code from the Billingcode drop-down list. 

e) Enter your comments in the Notes text box. 

9. Click Next to continue. The Schedule Job window appears. 
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Figure 149: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

10. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Time Interval to Schedule 
section. 

Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Time 
Interval to Schedule section is now enabled. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per your requirement. 
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 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

11. Click Next to continue. The Job Review window appears. 

 
Figure 150: Job Review window 

12. Click Finish to save the HP Integration job. The new job is added in the job list under HP 
DesignJet Jobs. 
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Run Job 
Run Job option is used to manually execute or perform a HP DesignJet job. It is necessary to run the job so 
that data gets imported from the HP DesignJet log files to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 

 
Figure 151: Job details window - Run job status and remarks 
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Chapter 14 
Xerox JBA Jobs 
In this chapter, you will learn about: 

• Overview 

• Creating Xerox JBARequest Application 

• Creating XeroxJBA Data Import Job 

• Run Job 
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Overview 
This section describes the integration of XeroxJBA Request application with Abacus Data Scheduler.  

To integrate with Abacus you must have XeroxJBA Request application. This could be installed on any 
machine. Here we assume that you have already installed XeroxJBA on your system. 

How the system works 

Abacus Data Scheduler pushes / populates the data to the Xerox JBA Request application. The populated 
data appears as fields on the Xerox JBA Request application.  

The XeroxJBA Request application is used to submit all the print jobs. The user fills the required fields on 
the XeroxJBA Request application before submitting print jobs. This information is stored in log files that are 
generated by XeroxJBA Controller. The log files are imported by the XeroxJBA Controller. You can 
schedule an import job in Abacus Data Scheduler to retrieve the log files from the KIP Controller. This 
retrieved data is manipulated by the Abacus system for generating reports and billing.  

Following is a pictorial representation of how the system works : 

 

 

 

 

 

How Abacus system works with Xerox JBA Controller  

Abacus Data Scheduler supports two types of XeroxJBA jobs: 

• XeroxJBA Request Integration Job: The Xerox JBA Integration Job defines the fields for 
Xerox JBA request application and pushes the Abacus data to the Xerox JBA controller.  
 

• XeroxJBA Data Import Job: Xerox JBA Data Import Job allows to read Xerox JBA Controller 
log files and import activities to the Abacus database. 
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Creating Jobs through XeroxJBA Request Application  
This option allows defining the billing dialog in Request application and populating Abacus data such as 
users, projects, billing codes, and notes to XeroxJBA Request application. 

To create jobs through XeroxJBA Request application: 
1. On the job list, click XeroxJBA. 

2. To create a new job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar. The Select Job Type window appears. 

 
Figure 152: Select Job Type window 
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3. Select job type as XeroxJBA Request Integration Job from the Job type drop-down 
list.  

4. Click Next to continue. The Create Job window appears. 

 
Figure 153: Create Job window 

5. Enter a job name in the Job Name text box.  

6. Under Import from controller section: 

a) Enter the IP address in the IP Address text box. 
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b)   Enter the Port as 8001. By default account console uses port 8001. If the port is 
changed during the installation, then enter the port number on which the XeroxJBA is 
configured. 

7. Select one of the modes. You can either select User Mode or PIN Mode. 

 In the User Mode, the user is validated based on user name and password. The 
user’s names will be displayed in a drop-down list and password entered by user 
will be validated against the user name. 

 In the PIN Mode, the user is validated based on the PIN numbers that they enter 

8. Click Next to continue. The Schedule Job window appears. 

 
Figure 154: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 
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9. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Time Interval to Schedule 
section. 

Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Time 
Interval to Schedule section is now enabled. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per your requirement. 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

13. Click Next to continue. The Job Review window appears. 
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Figure 155: Finish Job window 

14. Click Finish to save the XeroxJBA job. The new job is added in the job list under 
XeroxJBA Jobs. 
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Run Job 
Run Job option is used to manually execute or perform a XeroxJBA job. It is necessary to run the job so 
that data gets imported from the XeroxJBA log files to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 

 
Figure 156: Job details window - Run job status and remarks 
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Creating Jobs through XeroxJBA Data Import  
This option allows you create a “Pull” job to read the XeroxJBA log files. Whenever you run the “Pull” job, all 
XeroxJBA activities are imported from XeroxJBA log files to Abacus Database. 

To create jobs through XeroxJBA Data Import: 
1. On the job list, click XeroxJBA. 

2. To create a new job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar. The Select Job Type window appears. 

 
Figure 157: Select Job Type window 

3. Select job type as XeroxJBA Data Import Job from the Job type drop-down list.  
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4. Click Next to continue. The Create Job window appears. 

 
Figure 158: Create Job window 

5. Enter a job name in the Job Name text box.  

6. Under Import from controller section: 

a) Enter the IP address in the IP Address text box. 

b)   Enter the Port as 8001. By default account console uses port 8001. If the port is 
changed during the installation, then enter the port number on which the XeroxJBA is 
configured. 
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7. Click Next to continue. The Options window appears. 

 
Figure 159: Options window 

8. Select the device from the Select Device drop-down list.  

9. Select either Push Billing popup for these jobs check box or select the default data 
from the Default Data section. 

a) Select Push Billing popup for these jobs check box to display the billing popup after 
completion of each job. 

b) Select Apply Tracking Rules check box to apply the tracking rules for each job. 
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10. Under Default Data section: 

a) Select a project that you want to go through from the Project drop-down list. 

b) Select the project phase of the selected project that you need to read from the Phase 
drop-down list. 

c) Select a media from the Media drop-down list.  

d) Select a billing code from the Billingcode drop-down list. 

e) Enter your comments in the Notes text box. 

11. Click Next to continue. The Schedule Job window appears. 

 
Figure 160: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 
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12. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Time Interval to Schedule 
section. 

Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Time 
Interval to Schedule section is now enabled. You may choose to schedule a job at 
regular intervals or daily or weekly or monthly as per your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

13. Click Next to continue. The Job Review window appears. 



 
 

Abacus Data Scheduler 
         201 of 245 
 

 
Figure 161: Finish Job window 

14. Click Finish to save the XeroxJBA job. The new job is added in the job list under 
XeroxJBA Jobs. 
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Run Job 
Run Job option is used to manually execute or perform a XeroxJBA job. It is necessary to run the job so 
that data gets imported from the XeroxJBA log files to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 

 

Figure 162: Job details window - Run job status and remarks 
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Chapter 15 
LaserTrack Jobs 
In this chapter, you will learn about: 

• Overview 

• Creating LaserTrack Data Export Job 

• Creating LaserTrack Data Import Job 

• Run Job 
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Overview  
Abacus Data Scheduler supports two types of LaserTrack jobs: 

• LaserTrack Data Export Job: Laser Track Data Export Job allows exporting specific user 
details in a CSV file based upon your selection.  

• LaserTrack Data Import Job: Laser Track Import Job allows reading Laser Track controller log 
files and importing activities to the Abacus Database. For importing the user has to map all 
Controllers ID with the device name. You also need to apply tracking rules as per your 
requirement. 

Creating Jobs through LaserTrack Data Export  
Laser Track Data Export Job allows exporting specific user details in a CSV file based upon your selection. 

To create jobs through LaserTrack Data Export: 
1. On the job list, click LaserTrack. 

2. To create a new job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar.  

The Select Job Type window appears. 
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Figure 163: Select Job Type window 

3. Select LaserTrack Data Export Job from the Job Type drop-down list. 

4. Click Next to continue. The Create Job For Export Data window appears. 
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Figure 164: Create Job For Export Data window 

5. Under Job Details section: 

a) Enter job name in the Job Name text box. 

b) Click   (buddy button) and select the file residing path. 

c)   If the Abacus Data Scheduler is not installed on the same machine where LaserTrack 
Server is installed and you need to schedule this job, Abacus data scheduler service 
requires you to enter valid user information to access the file from the Abacus data 
scheduler service. Click User Authentication. The User Authentication dialog box 
appears. 
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Figure 165: User Authentication dialog box 

d)  Enter the user name and password to access the folder and click Test Connection to 
test the connection. Then click Save to save your settings. 

e) Enter the file name that is to be exported in the Export File Name text box. 

6.  Select the fields that you want to export from the Select Fields section. 

7. Click Next to continue. The Schedule Job window appears. 
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Figure 166: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

8. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Run Job section. 

Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Run Job 
section is now enabled. You may choose to schedule a job at regular intervals or daily or 
weekly or monthly as per your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 
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 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

9. Click Next to continue. The Finish Job window appears. 

 
Figure 167: Finish Job window 

10. Click Finish to save the LaserTrack job. The new job is added in the job list under 
LaserTrack Jobs. 
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Run Job 
Run Job option is used to manually execute or perform a LaserTrack Data Export job. It is necessary to run 
the job so that data gets imported from the LaserTrack log files to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 

 

Figure 168: Job details window - Run job status and remarks 
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Creating Jobs through LaserTrack Data Import  
Laser Track Import Job allows reading Laser Track controller log files and importing activities to the Abacus 
Database. 

To create jobs through LaserTrack Data Import: 
1. On the job list, click LaserTrack. 

2. To create a new job: 

 Right-click and select Create New Job. 

 Or, 

 Click New on the toolbar.  

The Select Job Type window appears. 

 
Figure 169: Create Job For Export Data window 
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3. Select LaserTrack Data Import Job from the Job Type drop-down list. 

4. Click Next to continue. The Create Job For Import Data window appears. 

 
Figure 170: Create Job For Import Data window 

5. Under Job Details section: 

a) Enter job name in the Job Name text box. 

b) Click   (buddy button) and select the file residing path. 

c)   If the Abacus Data Scheduler is not installed on the same machine where LaserTrack 
Server is installed and you need to schedule this job, Abacus data scheduler service 
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requires you to enter valid user information to access the file from the Abacus data 
scheduler service. Click User Authentication. The User Authentication dialog box 
appears. 

 

 
Figure 171: User Authentication dialog box 

d)  Enter the user name and password to access the folder and click Test Connection to 
test the connection. Then click Save to save your settings. 

6. Under Field Mapping section: 

a) Enter the controller id in the Controller ID text box. 

b) Select the device name from the Device Name drop-down list. 

c) Click Add New Row to add a row in Field Mapping list. 

d) Enter the width and length of the page in the Width and Length text boxes respectively. 

e) Select the Apply Tracking Rules check box to apply the tracking rules for the job. 

7. Click Next to continue. The Schedule Job window appears. 
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Figure 172: Schedule Job window 

Schedule job window is used to automatically run the activity at specified intervals. If you choose not to 
schedule a job, you can manually execute the job using Run Job option. 

8. Select Don’t schedule this job check box to avoid executing the import job 
automatically. Note that selecting the check box disabled the Run Job section. 

Or, 

Clear the Don’t schedule this job check box to schedule the job. Note that the Run Job 
section is now enabled. You may choose to schedule a job at regular intervals or daily or 
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weekly or monthly as per your requirement. 
 

 Select At regular interval check box. Specify the hours, minutes and seconds at 
which the job is automatically executed. For example, every 3 hours, 15 minutes 
and 34 seconds. 

 Or, 

 Select Daily check box.  Specify the time at which the job is automatically 
executed. For example, daily at 10:00:00 AM. 

 Or, 

 Select Weekly check box. Click a day and time at which the job is automatically 
executed. For example, every Monday at 12:45:05 PM. 

 Or, 

 Select Monthly check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

9. Click Next to continue. The Finish Job window appears. 

 
Figure 173: Finish Job window 
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10. Click Finish to save the LaserTrack job. The new job is added in the job list under 
LaserTrack Jobs. 

Run Job 
Run Job option is used to manually execute or perform a LaserTrack Data Import job. It is necessary to run 
the job so that data gets imported from the LaserTrack log files to the Abacus database. 

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till Abacus database files are processed.  
The job status and remarks are displayed in the job details window. 

 

Figure 174: Job details window - Run job status and remarks 
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Chapter 16 
Konica Jobs 
In this chapter, you will learn about: 

• Creating Device Konica Job 

• Run Job 
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Creating Device Konica Job 
This option allows you to create an import job to import data into the Abacus database from Konica.  Follow 
the given procedure to create a device Konica job. 

1. On the job list, select Konica. 

2. To create a device Konica job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar. 

Or 

 On the File menu, click New Job.  

The Create Device Konica Job window appears. 
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Figure 175: Create Device Konica Job window (1) 

3. Enter the Job details. 

a) Enter the job name in the Job Name text box. 

b) Select the job type from the Job Type drop-down list. 

c) Enter the valid server address in the Server Address text box. 

d) Enter the port number in the Port text box. 
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Figure 176: Create Device Konica Job window (2) 

4. Click Next to continue. The Choose Read Log Options window appears. 
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Figure 177: Choose Read Log Options window 

5. From the Billing popup display options section: 

• Select the Always option if you always want to display billing popup. 

• Select the When full information is not entered option if you want a billing popup to 
display while full information is not entered. 

• Select Never Display Billing popup option if you never want to display the billing popup 
for the jobs. 

• Select the Apply Tracking Rules check box if you want to apply the tracking rules for 
the jobs. 
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6. Under Use default values section, 

a) Select the project that you want to go through from Konica from the Project drop-down 
list. 

b) Select the project phase of the selected project that you need to read from the Konica file 
from the Phase drop-down list. 

c) Select a media from the Media drop-down list.  

d) Select a billing code from the Billingcode drop-down list. 

e) Select notes from the Notes text box. 

f) Select a device from the Device drop-down list. 

7. Click Next to continue. The Schedule Job window appears. 
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Figure 178: Schedule Job window 

8. The Schedule job window allows running the activity automatically at specified intervals. 
If you choose not to schedule a job, you can manually execute the job using Run Job 
option. 

 Select the Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Time Interval to Schedule area becomes disabled. 
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 Or, 

 Clear Don’t schedule this job check box to schedule the job. Note that the 
Time Interval to Schedule area is now enabled. 

9. You may choose to schedule a job at regular intervals or on daily basis or weekly basis 
or monthly basis as per requirement. 

 Select At Regular Interval check box. Specify the hours, minutes, and seconds 
at which the job is automatically executed. For example, every 4 hours, 5 
minutes, and 5 seconds. 

 Or, 

 Select Daily at check box.  Specify the time at which the job is automatically 
executed. For example, daily at 2:34:15 PM.  

 Or, 

 Select Weekly at check box. Click a day and time at which the job is 
automatically executed. For example, every Monday at 5:00:00 PM.  

 Or, 

 Select Monthly at check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

10. Click Next to continue. The Preview Summary window appears. 
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Figure 179: Finish Job window 

11. Review the import job details and click Finish.  
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Run Job 
Run Job option is used to manually execute or perform data import job.  

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job. 

2. Wait till data is read from the Abacus database and the files are processed. 
The job status and remarks are displayed in the job details window. 

 
Figure 180: Job Details window 
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Chapter 17 
Cisco Call Manager Jobs 
In this chapter, you will learn about: 

• Creating an Import Job 

• Run Job 
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Creating Import Job 
This option allows you to create an import job to import data into the Abacus database from Cisco Call 
Manager.  Follow the given procedure to create a Cisco Call Manager job to import data. 

1. On the job list, select Cisco Call Manager. 

2. To create a new data import job: 

 Right-click and select Create New Job. 

Or, 

 Click New on the toolbar. 

Or 

 On the File menu, click New Job.  

The Enter Data Import Job Details window appears. 
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Figure 181: Enter Data Import Job Details window 

3. Enter the Job details. 

• Enter the job name in the Job Name text box. 

• Select the source from where the data will be imported from the Import Source drop-
down list. You can either select File or Database as per your requirement from the drop-
down list.  

4. First, let’s select File and click Next to continue. The Config File Source window 
appears. 
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Figure 182: Config file source window 

5. Select the DataSource to configure an import job. 

a) Select an appropriate file type from which the data is to be imported. The available option 
in the Type drop-down list are: log, csv, txt or Excel file formats. 

b) Click   (buddy button) and select the file residing path. 

c) Select an appropriate Delimiter used to separate the values. The available options are 
Custom Delimited, TABDelimited, and CSVDelimited. The most common delimiters are 
colon, tab, and comma. 
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d) Select an appropriate option whether the input file has column header or not. 

6. Click Next to continue. The Preview Import Data window appears, which displays the 
list of data to be imported. 

 
Figure 183: Preview Import Data window 

7. To display the field mapping page, select the Show Field Mapping Page check box. 

8. Click Next to continue. The Field Mappings window appears. 



 
 

Abacus Data Scheduler 
         232 of 245 
 

 
Figure 184: Field Mappings window 

9. In the Field Mappings window, the source fields are mapped to the corresponding 
destination fields. You can also review and change the mapping if required. Column and 
Row filters can be set here depending on the conditions of import. Follow the given 
procedure: 
 
Select the Source Fields and then click corresponding Configure Row Filters to apply 
filter. The RowFilters window appears. 



 
 

Abacus Data Scheduler 
         233 of 245 
 

 
Figure 185:  RowFilters window 

10. From the Select Destinations and Columns section: 

a) Select the destination column from the Destination Column drop-down list. 

b) Enter a value for the destination selected in the Enter a Value text box or select the 
value from Choose an item drop-down list. 



 
 

Abacus Data Scheduler 
         234 of 245 
 

c) Click Add Filter. The value gets added under the RowFilters Summary list box. 

11. In the When the following conditions evaluates to section:  

a) Select the source from the Select Source drop-down list. 

b) Select an Operator from the drop-down list. The available options are:  =, in, between, 
StartsWith, EndsWith, and Contains.  
 

 “=/in” is used for specifying “if the value is equal to or in” 

 “between” is used for specifying “if the value is between 2 values say, 1-100” 

 “StartsWith” is used for specifying “if the value starts with” 

 “EndsWith” is used for specifying “if the value ends with” 

 “Contains” is used for specifying “if the value contains” 

12. Enter the values for the selected operator and click Add. The value gets included. 

13. If you want to add condition to the value, select the value and click Add Condition. The 
condition will be automatically updated under the RowFilter Summary. 

 
Figure 186: RowFilter Summary list box 

14. Click Close to close the RowFilters window. The condition gets added in the Row Filter 
Details section of the Field Mappings window. 

15. Click Next to continue. You may encounter with warning messages. However, it is not 
mandatory to apply filter conditions for all the columns. 



 
 

Abacus Data Scheduler 
         235 of 245 
 

 
Figure 187: Warning Messages 

16. Click Yes to continue. The Property Page appears. 



 
 

Abacus Data Scheduler 
         236 of 245 
 

 
Figure 188: Property Page window 

17. To configure external filters: (Optional) 

 Select the Script File check box, the text box below gets enabled. Click  
(buddy button) to select the appropriate script file.   

Or, 

 Select the Script check box, the text area below gets enabled. Type the external 
script filters in to it. 

18. Click Next. The Options window appears. 
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Figure 189: Options window 

15. Select the device from the Select Device drop-down list.  

16. Select either Push Billing popup for these jobs check box to display the billing popup 
after completion of each job. 

17. Select Apply Tracking Rules check box to apply the tracking rules for each job. 

18. Under Default Data section: 

a) Select a project that you want to go through from the Project drop-down list. 

b) Select the project phase of the selected project that you need to read from the Phase 
drop-down list. 

c) Select a billing code from the Billingcode drop-down list. 

d) Select comments from the Notes drop-down list. 
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19. Click Next to continue. The Schedule Job window appears. 

 
Figure 190: Schedule Job window 

20. The Schedule job window allows running the activity automatically at specified intervals. 
If you choose not to schedule a job, you can manually execute the job using Run Job 
option. 

 Select the Do not schedule this job check box to avoid executing the import job 
automatically. Note that the Time Interval to Schedule area becomes disabled. 

 Or, 

 Clear the Do not schedule this job check box to schedule the job. Note that the 
Time Interval to Schedule area is now enabled. 

21. You may choose to schedule a job at regular intervals or on daily basis or weekly basis 
or monthly basis as per requirement. 

 Select At Regular Interval check box. Specify the hours, minutes, and seconds 
at which the job is automatically executed. For example, every 4 hours, 5 
minutes, and 5 seconds. 
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 Or, 

 Select Daily at check box.  Specify the time at which the job is automatically 
executed. For example, daily at 2:34:15 PM.  

 Or, 

 Select Weekly at check box. Click a day and time at which the job is 
automatically executed. For example, every Monday at 5:00:00 PM.  

 Or, 

 Select Monthly at check box. Select the day and time at which the job is 
automatically executed. For example, on every 5th day of the month at 10:30:00 
AM. 

22. Click Next to continue. The Finish Import Job window appears. 

 
Figure 191: Finish Job window 

23. Review the import job details and click Finish. 
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24. Select the Database as a source from where the data will be imported from the Import 
Source drop-down list.  

25. Click Next to continue. The Configure 3rd Party Source Database window appears. 

 
Figure 192: Configure 3rd Party Source Database window 

26. Select the import database type from the Import Database Type drop-down list. 

27. Under Database connection info section: 

a) Enter valid server name in the Server text box. 

b) Enter the database name in the Database text box. 

c) Enter valid user id and password in the UserID and the Password text boxes 
respectively.  

28. To add DSN/File, first select the Use DSN check box and the DSN/File Name text box 

gets enabled. Enter the DSN/File name or click  (buddy button) to browse the exact 
location of the DSN/file. 
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29. The SQL Query is automatically generated when you select the Cisco Call Manager as 
an import database type and displayed in the SQL Query section. You can modify the 
query if required. 

30. Click Next to continue. The Preview Import Data window appears. 

 
Figure 193: Preview Import Data window 

31. The above window allows you to preview the Cisco Call Manager jobs, which enables 
you to view data from the source. 

32. To view the field mappings or to modify the mapping part, select the Show Field 
Mapping Page check box. 

33. Click Next to continue. The Field Mappings window appears. 
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Figure 194: Field Mappings window 

34. Map fields of Cisco Call Manager job to setup scheduling job. 

35. Click Configure Row Filters to apply filter if required. 

36. Click Next to continue. The Property Page appears. 
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Figure 195: Property Page window 

37.  To configure external filters: (Optional) 

 Select the Script File check box, the text box below gets enabled. Click  
(buddy button) to select the appropriate script file.   

Or, 

 Select the Script check box, the text area below gets enabled. Type the external 
script filters in to it. 

38. Click Next to continue. The Finish Job window appears. 
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Figure 196: Finish Job window 

39. Click Finish to save the Cisco Call Manager job.  

 
Run Job 
Run Job option is used to manually execute or perform data import job.  

To run job: 
1. Right-click the job name and click Run Job. 

Or, 
Select the job name. On the File menu, click Run Job.  

2. Wait till data is read from the Abacus database and the files are processed. 
The job status and remarks are displayed in the job details window. 
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Figure 197: Job Details view 
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